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Table 1. Changes to this manual

Date Description

Release 6.11.1

* SMTP server - User can define which port to use for the SMTP server Table 3, "General
Settings dialog box options," on page 82, “Figure 10. General Settings dialog box” on
page 81

¢ Table 3, "General Settings dialog box options," on page 82 - Option in User Connections

May 2013 section renamed to Do not allow more than one concurrent connection per user

¢ Windows 8 and Windows Server 2012 operating systems supported: “Table 1. SERVER
Operating Systems - Windows” on page 7, “Table 2. CLIENT Operating Systems -
Windows” on page 8

Revised:

¢ “Small Deployments” on page 3
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Table 1. Changes to this manual (Continued)

Date

Description

March 2013

Release 6.11

e Clarified Task - “Adjust the Video Wall layout and control” on page 96

* Load/Save Video VideoWall layout “Save Current Video Wall Layout/Load Current Video
Layout” on page 102

e Security Configuration - Symphony Users Devices tab - mentioned new Talk through
camera and Listen to camera options (default allow) “Modifying Access Rights for a
Group” on page 41

¢ Symphony supports two-way audio - “Figure 2. Server Configuration for a network
camera” on page 16 and “Table 1. Network tab - Field/button description” on page 17

¢ Limit user login to once per server farm - “Figure 10. General Settings dialog box” on
page 81 and “Table 3. General Settings dialog box options” on page 82

¢ Video recording schedule in per minute range - “Figure 4. Recording schedule” on page
21, “Table 2. Conditions under which video is recorded” on page 21

e Administrator can view which users are using a camera - “ Displaying a List of Users
Viewing a Camera” on page 105

¢ “QOverload Protection” on page 69“Figure 1. Server Farm” on page 68

* “Manage Servers - Client Update” on page 70, “Figure 2. Device Pack Update
Installations Managed by Server” on page 70, “Figure 3. Device Pack Installation Update
Message to Client User” on page 70

¢ Select narrower time frame for View Detailed Events - “Figure 30. View Detailed Events”
on page 106

¢ Email notification option in Notifications dialog changed for clarity to Video or Search
deleted from Footage/video deleted - “Figure 13. Notifications” on page 87, “Table 5.
Event Descriptions” on page 88

Other

e Clarified - “ Enabling Control Buttons” on page 29 - now EnablePTZButtons parameter

¢ Clarified- “Table 2. Conditions under which video is recorded” on page 21, “Figure 3.
Video tab” on page 20

e Clarified - “ Panoramic Settings group box:” on page 22

e Clarified- “Task 2: Configure SNMP Service Security” on page 109

¢ Removed - Saving/Emailing Images from Scheduled versus Manual Reports

e First important note in “ Single Sign-On (SSO)” on page 33

December 6, 2012

Updated license information: “Symphony Server Licensing” on page 6

November 15,
2012

New features in Symphony Release 6.10.1
Video decorations options - “Table 3. General Settings dialog box options” on page 82

Video Wall - In video wall manager, you can double-click on a panel to display the image in
full screen mode. Double-clicking again restores the view to the previous state. “Full Screen
Mode” on page 102

Added:
More guidelines around NAS and SAN storage. See “Storage” on page 76
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Table 1. Changes to this manual (Continued)

Date Description

Revised: “ Adding Digital Input and Output to Maps” on page 61. Supported DIO devices
now listed in KB article: http://www.aimetis.com/Support/kbarticle.aspx?ID=10141

Revised: Table 5, "Event Descriptions," on page 88

Footage/Video deleted

September 13, A user has deleted one of the following:

2012 * video from the system

e a recurring search definition: no footage will have actually been deleted as a result, the
recurring search simply will not continue to recur

¢ a search result: the metadata about the result will be removed as well as the .aira and
.mpg files saved explicitly for that result (the original footage is untouched)

Added:

“Tracking Color” on page 9

Release 6.10

August 2012

¢ “Prerequisites” on page 7

e “Supervisor Logon” on page 48

* “Table 1. Network tab - Field/button description” on page 17 - New option “Support
Direct Connect” on page 18

August 2012 . .

¢ Added “If there are multiple servers in a farm, all the servers must have the same
directory tree structure for the path being used to save reports.” in “Reports” on page
126

¢ Updated - “ Saving/Emailing Images from Scheduled versus Manual Reports” on page

125

Added:
* Table 1, "Network tab - Field/button description," on page 17 with extensive information

on “FPS” on page 18

May 2012 * Link to Knowledge Base article on Access Devices in “Device - I/0” on page 26

¢ Link to Documentation for Cardax and Axiom RBH integration guides in “Device - I/0” on
page 26

Removed: PTZ Calibration Beta

Added:
¢ “Rules in Symphony for Cameras with Digital I/O” on page 24 - Reference to Aimetis

Symphony Analytics and Rules Guide
March 5, 2012 ¢ “Rules in Symphony for I/O Devices” on page 28 - Reference to Aimetis Symphony
Analytics and Rules Guide

Corrigendum:
¢ “Ban Live Video” on page 45 - removed quotation marks around Value=UserBanGroup
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Table 1. Changes to this manual (Continued)

Date

Description

February 28, 2012

Release 6.9.1

New:

“Figure 10. General Settings dialog box” on page 81 - now includes SMTP email server

authentication

“Figure 13. Notifications” on page 87 - SMTP option moved from Notifications to General

Settings, and description for new email server authentication option in Table 3, "General

Settings dialog box options," on page 82

“Saving/Emailing Images from Scheduled versus Manual Reports” on page 125 - Images

from scheduled Heat Map reports can be saved/emailed.

Revised:

» “Figure 2. Server Configuration for a network camera” on page 16

* “Analytics Engines and Analytics Configuration Tabs - Add Video Engines” on page 24 -
reference to new Analytics guide

¢ “To acknowledge an alarm (rule on map):” on page 61

February 1, 2012

Update to SNMP mib file table based on Symphony 6.9
“Enabling SNMP” on page 108 - See Table 7, "Mib file details," on page 112 alarm Monitor
Category and added Trap column.

January 31, 2012

This is a new guide. Analytics content now in a separate guide.

Release 6.9

Added:

¢ “Ban Live Video” on page 45 - Setting up user groups

* “On-Camera Storage” on page 77 - For AXIS cameras

¢ “Managing General Settings” on page 81 - Footage size polling rate

e “Reports” on page 126 - File permissions for scheduled and manually run reports

Revised:
¢ “Software Overview” on page 2

¢ “Symphony Web Access” on page 125 - More than 100 cameras in Camera Tree, Web
Client shows video from cameras as separate pages, navigated by forward and back
buttons.
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Table 1. Changes to this manual (Continued)

Date

Description

November 28,
2011

Release 6.8

Revised:

¢ “Adding Digital Input and Output to Maps” on page 61
e “Customizing Digital Input and Output Names” on page 63
¢ “Activating an Output Device Using the Map Context Menu” on page 65

Added:

* “Digital I/0O Tab” on page 23

¢ “Figure 5. Adding an Axis Camera with Digital /O invokes a Digital I/O tab in the Server
Configuration dialog box” on page 23

* “Figure 6. Digital I/O tab for Axis Cameras in Server Configuration dialog box” on page 23

¢ “Figure 7. Axis Camera I/O” on page 24

* “Figure 9. HardwareDevice tab - I/O for Phoenix Devices” on page 27

* “Figure 10. Phoenix I/O displayed in Camera Tree dialog box” on page 28

 “Single Sign-On (SSO)” on page 33

Sym 6.7-P-203

September 7,
2011

Added:
Video and logs should be stored in separate folders... in “Customizing Storage Settings” on
page 66.

September 6,
2011

Release 6.7.1
Added:
¢ Table 3, "Conditions under which audio is recorded," on page 22- Rule Broken option

¢ “Figure 37. Manage Services dialog box” on page 118- Log on as Local System account
option
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Table 1. Changes to this manual (Continued)

Date Description

Corrigendum
Not in release 6.7

“ H ”

August 18,2011 | - - ification

ADAM devices only for Digital I/O on maps, see “ Adding Digital Input and Output to Maps”
on page 61

Release 6.7

Added:
August 2011 “Control PTZ Camera Auxiliary Outputs” on page 29
“Using Maps” on page 57
e  “Icons on Map” on page 57
e  “Adding Rules to Maps” on page 59
e “Adding Digital Input and Output to Maps” on page 61

Sym-6.6-P-200.5

Added:.

e Link to external reference“HTTPS for AXIS” on page 120.

June 14, 2011 Revised:

Icon change for Notes and Examples. “Conventions” on page x.
Font change - highly readable for both online and print documents.

Sym-6.5-P-200.7

December 16, Revised:
2010 “Enabling SNMP” on page 108.
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Table 1. Changes to this manual (Continued)

Date Description

Revised:
* Note in “Device - Analog Cameras” on page 25

¢ “Configuring and Managing a Video Wall” on page 90

Removed:
e Server Sets information

Added:
¢ “User Authentication” on page 32

¢ “Symphony Security Authentication Mode” on page 32

¢ “Active Directory Authentication Mode” on page 32

November 10, * “Associating Groups with Active Directory” on page 44

2010 * “Advanced Information - Active Directory Associations” on page 54"

¢ “Authentication Mode Set to Active Directory (in Installation Setup Wizard)” on page 54
¢ “Synchronizing with Active Directory” on page 54

¢ “Periodic Synchronization” on page 55

* “Logging on to Symphony if your user does not exist in Symphony” on page 54
* “Groups Associated with Active Directory” on page 54

* “When a user joins another Active Directory group:” on page 56

¢ “Farm Setup” on page 71

¢ “Creating a Farm from Multiple Existing Farms” on page 71

¢ “Buddy System” on page 75

¢ “Redundancy Configuration Settings” on page 75

October 6, 2010 | First version of this document. Symphony v6.5.3
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Table 1. Symbols and formatting used in this manual

Icon

Caption/Format

Description

Additional information.

Note
Example scenario.
Example
Vital additional instructions or links.
Important
You could lose recording footage or you must pay close attention to
. setting changes.
Caution & &

Bold, Arial Font

Graphic User Interface term (button, menu, window, option) or
keyboard item.

Italic, Arial

Emphasis, new term, or an external reference.
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Table 2. Aimetis documents and videos

Document Name

Links

Symphony Release Notes

https://www.aimetis.com/Xnet/downloads/documentation.aspx

Symphony Installation Guide

https://www.aimetis.com/Xnet/downloads/documentation.aspx

Symphony Administration
Guide

https://www.aimetis.com/Xnet/downloads/documentation.aspx

Symphony Analytics Guide

https://www.aimetis.com/Xnet/downloads/documentation.aspx

Symphony Client User Guide

https://www.aimetis.com/Xnet/downloads/documentation.aspx

Knowledge Base Articles

http://www.aimetis.com/Support/knowledgebase.aspx

Case Studies

http://www.aimetis.com/Solutions/customers-case-studies.aspx

White Papers

http://www.aimetis.com/Solutions/whitepapers.aspx

Application Video Samples

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Recorded Webinars

http://www.aimetis.com/Events/webinars.aspx

Product Tour

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Supported Video Devices List

http://www.aimetis.com/Support/supported-video-devices.aspx

Licensing

http://www.aimetis.com/Symphony/default--licensing.aspx

FAQ

https://www.aimetis.com/Xnet/Support/fags.aspx
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Aimetis Xnet Portal

Eﬂetis xnet

Account Management Downloads

Marketing Translation Submit Videos

My Settings | Log Out

Create Account

& Place Order

Issue Credit
@ Inventory (2950)
(X Order History

Product Keys

‘ @® Account Settings

Admin Views:
All Farms/ Servers
All Cameras

% Aimetis: [ searcn |

) FarmsiServers (1) Home - Aimetis:
Add ¥

&) CamerasiEmbedded (0) | |Announcements:
Add ¥ Welcome to the new Aimetis Extranet. If you have any questions about our new site or encounter any technical problems, please contact our support team.

% Users (1)
Add & Notes

Favorites

»

111

Figure 1. Aimetis Xnet home page

Xnet is the Aimetis Online Portal: www.aimetis.com/Xnet

You can:

e  Order Licenses

e Manage Sub-Partner Accounts

e Access Technical Support & Downloads

e Access Sales &
e Access Aimetis

Marketing Tools
Software Translation

Note: Access to tools depends on account type, for example, Distributor,
Certified Partner, Authorized Partner, End-User. For instructions, see Table 3 on

page xii.

Table 3. Instructions for using the Xnet

Xnet Instructions

Links

Xnet Training Manual -
Resellers

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Recorded Webinar - Xnet
Training - Distributors

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx
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Table 3. Instructions for using the Xnet

Xnet Instructions

Links

Recorded Webinar - Xnet
Training - Channel
Partners

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Xnet Training Manual -
Distributors

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Aimetis Symphony
Architectural and
Engineering Specification

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx

Hardware Benchmarks
guidelines for 10, 20, 40
and 200 camera systems.

https://www.aimetis.com/Xnet/Marketing/collateral-library.aspx
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Contact Us

Table 4. Contact links, addresses, phone numbers

Contact Type

Description

About Aimetis

http://www.aimetis.com/Company/default.aspx

Contact link

http://www.aimetis.com/Company/contact.aspx

Support link

http://www.aimetis.com/Support/default.aspx

Americas

Aimetis Headquarters

500 Weber Street North

Waterloo, Ontario, Canada

N2L 4E9

Phone: +1866-544-2804 or +1 519-746-8888
Fax: +1 519-746-6444

EMEA

Aimetis GmbH

Am Prime Parc 7

65479 Raunheim

Germany

Telefon: +49 (0) 6142 207 98 60
Fax: +49 (0) 6142 207 98 89
www.aimetis.de

Asia - Pacific

Aimetis China

Rm. 1328 Yunsun Tower
2025 Zhongshan West Road
Xuhui, Shanghai

China 200235

Phone: 86-21-6182-6916
Fax: 86-21-6182-6777
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Overview and Prerequisites

Overview and Prerequisites

Learn about...

“Software Overview” on page 2

“Symphony Server Licensing” on page 6

“Prerequisites” on page 7

“Server” on page 7

“Client” on page 7

“Operating Systems, Database, and Browsers” on page 7

“Client Prerequisites Installed Automatically” on page 10

“Server Prerequisites Installed Automatically” on page 10

“Symphony Installation and Data Folders” on page 12
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Software Overview Overview and Prerequisites

Software Overview

An installation of Aimetis Symphony™ has two components: server software and client software.

Server Computer

The server computer functions as the intelligence management system that computes the most complicated and
intricate tasks.

Figure 1. Server computer

At larger surveillance sites, the server computer may actually be multiple computers linked together to form a
Server Farm

Figure 2. Server Farm

Server and Client Computers

Cameras

Network

Clients Server Farm

Figure 3. Server Farm with many clients
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Server and Client Computers Overview and Prerequisites

You can set up clients on many computers or workstations. A typical site would have many client computers
connecting to a dedicated server computer. At larger sites, the server computer may actually be multiple
computers linked together to form a Server Farm.

Small Deployments
For small deployments, the server and client computer can be one computer. However, you must consider
the following:

¢ You cannot use multi-views

e The server must be able to handle the additional load, that is, there server has enough CPU and a
good video card

Ideally, we do NOT recommend installing the server on client on one computer.

e Regular users should not have access to the server machine because someone might turn off the
machine, change the software or configuration on the machine, or even inadvertently crash it.

e Also, using the machine for other tasks may take up a lot of CPU/RAM/network/disk bandwidth
and prevent the Symphony server components from working efficiently.

oF

Cameras

etwork '

Server & Client

Figure 4. Server and Client on one computer
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Client Software Interface

Overview and Prerequisites

Client Software Interface

The client software provides the user interface for all tasks including monitoring, searching, reporting and

configuration.

Figure 5. Symphony Client interface

The interface can be arranged over two monitors, and you can even use a Video Wall (a collection of monitors

could be on a single wall in a room or in different physical locations).

Overview and Prerequisites



Server Software Interface

Overview and Prerequisites

Server Software Interface

The server computer is usually and ideally separate from client computers. This is not the case for Aimetis

software.

In Figure 6, “Symphony Client” appears in the blue title bar. This is the client interface. You access the server
computer through the Server menu option in this interface.
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Figure 6. Server menu item in Symphony Client interface

The interface for both server and client are integrated so that you can connect (configure server tasks) from any
client computer in a site. Personnel will often be at client workstations. They must be able to connect to the
server (to set up features, for example) from their workstations.

The server software handles all video recording and analytics. It is the intelligence management system that

computes the most complicated and intricate tasks.

Overview and Prerequisites
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Overview and Prerequisites

Symphony Server Licensing

If you are upgrading an existing installation, ensure that your licenses are eligible for the software version you

are installing. If not, contact your Aimetis distributor for an upgrade.

Aimetis Symphony is licensed on a per camera basis. Each physical computer can have multiple Symphony
software licenses. The license types are: Standard, Professional and Enterprise. No server or client license fees

apply.

License Type Description

Symphony Server Standard License

Contains all core video management features. For details, see
Aimetis Technical Specifications on the Aimetis Web site.

Symphony Server Professional License

site.

Contains all core features of the Standard License plus advanced
functionality. This license type is used in large deployments. For
details, see Aimetis Technical Specifications on the Aimetis Web

S h S Ent ise Li .
ymphony Server Enterprise License such as people counting.

Web site.

Building on the functionality found in Professional, video analytics
can be added on a per camera basis which augments the accuracy
of alarm monitoring and includes business intelligence reporting

For details, see Aimetis Technical Specifications on the Aimetis

Licenses can be mixed per physical server, allowing Standard, Pro, and Enterprise to be used per single server.
However, there is no advantage of having Standard and Professional licenses mixed on the same server since

advanced VMS features will be available only if all licenses are Professional or higher.

Overview and Prerequisites
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Prerequisites

Overview and Prerequisites

Prerequisites

Server

e Any Intel CPU or any AMD CPU that supports SSE2 (for example, Opteron)
e 500 Megabytes of free disk space

e At least 1 Gigabyte of RAM

Client

e 200 Megabytes of free disk space

e 2 GHz or faster processor is recommended

e Atleast 1 Gigabyte of RAM

Operating Systems, Database, and Browsers

e S =Supported

e R =Recommended

e G =Recommended for a deployment of greater than 20 cameras

¢ N = Not supported

e K =See Knowledge Base on Aimetis Xnet

Table 1. SERVER Operating Systems - Windows

Windows Windows
Symphony Windows XP |Server Windows |Server Windows
Product Version |SP32 2003 Vista? 2008 R2° | windows 7 |Server 2012 |Windows 8
6.5 S S.R,G SR N N
6.6 S S S S.R,G SR N N
6.7 S S S S.R,G SR N N
6.8 S S S S.R,G SR N N
6.9 S S S S.R,G SR N N
6.10 S S S S.R,G SR N N
6.11 S S S S.R,G SR S S
a. See Windows Vista and XP Microsoft End of Support Solution Center
http://windows.microsoft.com/en-us/windows/help/end-support-windows-xp-sp2-windows-vista-without-service-packs?os=other
b. Windows 2008 R2 does not install sound components by default. You must install the Desktop Experience Windows component.
7
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Operating Systems, Database, and Browsers Overview and Prerequisites

Table 2. CLIENT Operating Systems - Windows

Windows Windows

Symphony Windows | Server Windows |Server Windows

Product Version |XP SP32 |2003 Vista? 2008 R2P | Windows 7 |Server 2012 |Windows 8
6.5 S S S S S,R,G N N

6.6 S S S S S,R,G N N

6.7 S S S S S,R,G N N

6.8 S S S S S,R,G N N

6.9 S S S S S,R,G N N

6.10 S S S S S,R,G N N

6.11 S S S S S,R,G S S

a. See Windows Vista and XP Microsoft End of Support Solution Center
http://windows.microsoft.com/en-us/windows/help/end-support-windows-xp-sp2-windows-vista-without-service-packs?os=other
b. Windows 2008 R2 does not install sound components by default. You must install the Desktop Experience Windows component.

Table 3. Database (SQL Server)

Symphony SQL Server | SQL Server |SQL Server | SQL Server
Product Version |2000 2005 2008 2012

6.5 S S/R N

6.6 S S/R N

6.7 S S/R N

6.8 S S/R N

6.9 S S/R N

6.10 S S/R N

6.11 S S/R N

Ensure that the SQL Server database is on a local network (100 Mbps or greater) connected to the servers in the
farm.

Overview and Prerequisites
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Operating Systems, Database, and Browsers

Overview and Prerequisites

Table 4. Browsers

Symphony Product

Version IE62 |IE7> |IE8 |Firefox 3.x Safari 5 [Chrome 5
6.5 R * * *
6.6 R * * *
6.7 R * * *
6.8 R * * *
6.9 R * * *
6.10 R * * *
6.11 R * * *

a. Limited support for 64-bit version of IE.

*Limited support (reports, alarms, timeline, JPGs). No live or historical video.

Table 5. Virtualization Platforms

Symphony Product Version

Microsoft Virtual PC

VMware Server

6.5

6.6

6.7

6.8

6.9

6.10

6.11

ninnnnnin

|V | OV| DD |0
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Client Prerequisites Installed Automatically
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Client Prerequisites Installed Automatically

The following prerequisites are required by Symphony and (if necessary) will be installed automatically.

Table 6. Client Prerequisites

install)

8.0.50727.4053)

Item Version commandline install
XML 6.0 SP1 (x86) 6.10.1129.0 msxml6_x86.msi /qn
XML 6.0 SP1 (x64) 6.10.1129.0 msxml6_x64.msi /qn
Visual C++ 2008 Redistributable Package 90 (components installed by merge modules in
(x86) installer)
Microsoft .Net 3.5 SP1 3.5SP1 dotnetfx35 /q /norestart
8.0 (Service Pack 1
Visual C++ 8.0 Redistributable (exe \L,JV;[:a':,L Security Vcredist_x86_ATLUpdate.exe /q

Microsoft Data Access Components
(MDAC) 2.8

2.80.1022.3

Setup.exe

Aimetis Core

6.11.0.0

Msiexec /i AimetisCorelnstall.msi /g

Server Prerequisites Installed Automatically

The following prerequisites are required by Symphony and (if necessary) will be installed automatically.

Table 7. Server Prerequisite

Item Version commandline install

XML 6.0 SP1 (x86) 6.10.1129.0 msxml6_x86.msi /gn

XML 6.0 SP1 (x64) 6.10.1129.0 msxml6_x64.msi /gn

Visual C++ 2008 Redistributable Package 90 (components installed by merge modules in
(x86) installer)

Microsoft .Net 3.5 SP1 3.55P1 dotnetfx35 /q /norestart

Visual C++ 8.0 Redistributable (exe
install)

8.0 (Service Pack 1
with ATL Security
Update,
8.0.50727.4053)

Vcredist_x86_ATLUpdate.exe /q

Microsoft Data Access Components
(MDAC) 2.8

2.80.1022.3

Setup.exe

Aimetis Core

6.11.0.0

Msiexec /i AimetisCorelnstall.msi /q

Overview and Prerequisites
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Server Prerequisites Installed Automatically Overview and Prerequisites

Table 7. Server Prerequisite (Continued)

Item Version commandline install

SNMPInstallLauncher.exe
"INSTALLDIR=[INSTALLDIR]" (Required files,
SNMPInstallLauncher.exe, SNMPSetup.exe,
SNMPSetup64.exe)

SQLEXPR_x86_ENU /Q /HIDECONSOLE
/ACTION=Install /INSTANCENAME=AIMETIS
/FEATURES=SQLENGINE /SECURITYMODE=SQL
Microsoft SQL Server Express 2008 R2 10.50.2500.0 /SAPWD=[SQL_SA_PASSWORD]

SP1 o ) /IACCEPTSQLSERVERLICENSETERMS
/SQLSVCACCOUNT="NT AUTHORITY\SYSTEM"
/SQLSYSADMINACCOUNTS="Builtin\Administrators"

Aimetis SNMP 6.11.0.0

Windows Installer 4.5 4.5 [program] /quiet /norestart

OPC Core Components 2.00

Redistributable 2.00.2.20 N/A

11
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Symphony Installation and Data Folders

Symphony Server

Symphony server stores three kinds of data to your hard disk.

e Binary application files
e Video data
e Configuration information stored in a SQL Server Database.
Symphony is installed by default in
C:\Program Files\Aimetis\Symphony\
or on 64 bit 0OS
C:\Program Files (x86)\Aimetis\Symphony
The default path for all data (log files, video, etc.) is

C:\Program Files\Aimetis\Symphony\data\

You can change the:

e default installation path during installation of Aimetis Symphony v6.11.
e default data path during the Setup Wizard.

Table 8 provides a summary of key folders

e  <AppRoot> denotes installation path
e <DataRoot> denotes data path)

Table 8. Key Folders

Path Description

<AppRoot>\_bin Binaries for all Aimetis Symphony v6.11 executables and DLLs

Small .txt files storing alarm instructions and Aimetis.com's IP

<AppRoot>\_docs address

Tools and utilities that Aimetis Support Specialists use to

<AppRoot>\_tools

diagnose system problems

Scripts for configuring Symphony. For example, a database

<AppRoot>\_Scripts schema creation script for manually creating the Symphony
database
<AppRoot>\WebRoot Web files & binaries

<DataRoot>\_footagearchive

Video data recorded from all cameras

<DataRoot>\_images

A cache of JPEG images generated from the footage

<DataRoot>\_logs2

All server log files useful for debugging and diagnosing
problems.

<DataRoot>\_searches

Stored searches. These files will not be automatically cleaned
and searches must be manually deleted by user

<DataRoot>\_signals

Timeline data (green, yellow, red)

Overview and Prerequisites
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Symphony Server

Overview and Prerequisites

Table 8.

Key Folders (Continued)

Path

Description

<DataRoot>\_signals2

XML metadata for searches and reports

<DataRoot>\Reports

Location for generated reports. Depending on
write-permissions, a generated report will be stored in the
\Data\Reports folder on the master server machine. The folder
is generated ONLY after a report has been run and saved.

\windows\temp\config_backup\

Location for automatic backups of server configuration

In addition to the folders listed in Table 8, Symphony Server adds the following registry keys:

HKIM\Software\Aimetis

Some configuration data for the server is stored here, such as the database connection string.

Caution: It is highly recommended that the <DataRoot> folders are not on the
same physical Hard Disk as Windows and <AppRoot>. This is to limit the amount
of disk read and writes to the OS disk to prevent catastrophic failure.

Overview and Prerequisites
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Symphony Client Overview and Prerequisites

Symphony Client

Aimetis Symphony Client is installed by default in
C:\Program Files\Aimetis\Symphony Client\

Key Folders

Table 9. Key Folders for Client

Folder Description

C:\Documents and

Settings\$WINUSERS\Application All client configuration, such as window layouts,

general configuration, logs

Data\Aimetis\
C:\Documents and Settings\All This folder contains RegisteredFarms.xml and
Users\Application Data\Aimetis\ Il

Note: These paths may be slightly different on different operating system
versions.

These files define the farms that have been registered. The default is whatever the client configuration path is
set to but you can override this. The pathsin Table 9 can be configured via the Aimetis Symphony Client Settings
dialog box.

e From the View menu, select Settings.
Two (optional) variables can be used in the path names:

e %WINUSER% represents the Windows username of the current user. This is used in the default
path so Symphony can store the configuration in the current user’s application data folder.

e %SYMPHONYUSER% represents the Symphony username. This is valid only if credentials are
required for login to Symphony.

If a customer prefers to keep these settings global, do not use either of these variables when specifying the paths.
In addition to the folders in Table 9, Aimetis Symphony Client adds the following registry keys:
HKILM\Software\Aimetis\AiraExplorer

14
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Setting Up Devices

Chapter 1

Setting Up Devices

Three kinds of device types can be added to Symphony Server.

e  “Device - Network (IP) Cameras or Video Servers” on page 16

e “Device - Analog Cameras” on page 25

e “Device - 1/0” on page 26

Chapter 1

Important: For a list of supported devices, see
http://aimetis.com/Support/supported-video-devices.aspx.

If you select a multi-lens camera, multiple licenses will be required. You must
contact Sales to be given the difference in licenses.

Procedure

To view devices:

e From the Server menu, select Configuration. The Configuration dialog box appears with Devices

displayed in the right pane.

Server Configuration - [ts1-test] - Devices Sumrmary

(o8

@ Rules

[
I:a"l Licenses
£ Motifications
{0 General Settings

| Skorage

<[ 151

;ﬂ Server Farm

= Client Connectivity
L&) Carousels

You can add, remove, or modify cameras here,

ey |V| Impaort Cameras From File |
Export Cameras To File |
Create Blank Impoart File |
jin} Marme Server Type Status Others
» 1|Cameral |TSI |Netw0rk PTZ Camera Mormal [10.234.2.83:80] [User:user] [AXIS 214] [Serv...

OK Cancel

Chapter 1

Figure 1. Server Configuration dialog box showing Devices
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Device - Network (IP) Cameras or Video Servers

Chapter 1
Device - Network (IP) Cameras or Video Servers
For network cameras or video servers, you can:
e Add a network camera
e Configure advanced features, for example, recording schedule
e Configure analytics engines (Enterprise license only)
Procedure
To add a new network camera or video server:
1. From the Server menu, select Configuration. The Configuration dialog box appears with Devices
displayed in the right pane.
2. Inthe right pane, click New. The Network tab appears.
Server | j
Video ] Diggital 102 ] Analytics Engines | Analytics Configuration l
Mame |Camer32 Discover Devices
Description|
iy on Yveb
IDiCode |
Supported Festures
URL |
e, 10.1.2.3 {port 80}
10,1,2,3:120
rksp:ff10.1.2. 3fmpeg4i1 fmedia. amp {pork 5543
rtsp:ffuser:password@10.1.2,3: 1666/ capture
Manufacturer | acTi -
Arecont
Axiz
Bsler il AXIS M1031.W
Lizername Pazsyword |+
Connect to Camera
Camera Type
ol o) o)
Resolution FP= Yideo Format Failover Movability
Banx480  w| |5 x| |mres x| |movane |
[ Support Direct Connect [ Enable Audio Input [ Enable Audio Output
Ok Cancel
Figure 2. Server Configuration for a network camera
16
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Device - Network (IP) Cameras or Video Servers

Chapter 1

Table 1. Network tab - Field/button description

Field/button

Description

Discover Device

Opens the Discover Device dialog box displaying a device tree. Expand the
brand name to see a list of devices.

Discover Devices - localhost =Npy X
Right dlick on a device for options.

- ACM1231 (10.234.2.123)

- ACM3401 (10.234.2.122)

- ACM5611 (10.234,2,121)

- CAMB630 (10.0.0.1)

- KCM5111 (10.234.66.65)

- SED2600 (10.234.2.74)

-~ TCM4301 (10.234.2,110)

-~ TCM5311 (10.234.2,170)

- AXIS (58)

(- Bosch (7)

- Dinion-IP-MWC (10.234.2,116)
- Dinion-IP-MWC (10.234.2,23)
- Dinion-IP-MWC (10.234.5.113)
- FlexiDome (10.234.6.21)

- FlexiDome NDN-498-P (10.234.6.40)
. Gen4 (10.234.2.205)

- VIP-X1600-M45 (10.234.2.24)
H- IQeye (11)

- VC (2)

H-Moxa (1)

- Panasonic (15)

+- Samsung (25)

H- StarDot (2)

[En M= = e e ]

Ready

View on Web Browser

Opens a Web browser to the camera URL (IP address).

Supported Features

Opens the Web browser to the Aimetis Xnet list of supported devices.

Server The name of the server managing cameras.
Name Enter an appropriate and easily identifiable name for the camera.
i Enter an easily identifiable description. For example, “Camera near front
Description "
door.
ID/Code Enter the code or identification you are using to classify and easily identify
your cameras.
URL IP address of the device
Manufacturer Identify a camera in your system by selecting it by brand name.
Enter a username to access the camera. This may be pre-established based
Username
on your company protocol.
Enter a password to access the camera. This may be pre-established based
Password

on your company protocol.

Connect to Camera

The Symphony server connects with the camera and automatically detects
the Resolution, FPS, and Video Format.

Chapter 1
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Chapter 1

Table 1. Network tab - Field/button description

Field/button

Description

Camera Type

Select one of the options: Fixed, PTZ, or Video Server

Fixed

Fixed camera type.

PTZ

A Pan-Tilt-Zoom type camera.

Video Server

For a device that uses COAX input (from an analog camera), has a
compressor, and network port as output.

Resolution

Various resolutions, for example, 160x120, 176x144, 240x180, 320x240,
480x360, 640x480

FPS

Frames Per Second

Example Scenario:
e On-camera FPS =5

e User selects a video analytic with a default FPS (or chooses an FPS) that is
different from the on-camera setting, for example FPS =8

Results:
¢ If camera synchronizes with Symphony settings, then FPS=8 will be used

for streaming from cameras, decompression, video analysis, writing to
disk, live video, historical recording, and searches.
e IfVideo Format = MJPG

e  FPS=8 will be used for streaming from camera,
decompression, and video analytics.

e FPS=5 will be used for writing to disk, live video,
historical recording, and searches.

¢ If camera does NOT synchronize with Symphony settings, then the
on-camera FPS dictates, regardless of the setting in Symphony. As such, in
our example, FPS=5 will be used for streaming from cameras,
decompression, video analysis, writing to disk, live video, historical
recording, and searches.

Video Format

Various formats based on camera type: MJPG, H264, H264 Unicast, H264
Multicast, H264 Over TCP, H264 Over HTTP, H264 over HTTPS

Failover Movability

If set to Movable, then this device can move to another server in the farm
during failover.

If set to Unmovable, then the device cannot be moved. Any device that
requires access to resources available only on a single server (for example,
COM port, special SDK or drivers) is unmovable. All others are typically
movable.

Enable audio streaming

Depending on camera, allows live audio.

Support Direct Connect

Depending on camera, allows direct connection to camera versus via server
when View>Settings>Video tab, Direct connect to camera check box also
selected.

Enable Audio Input

Depending on camera design, allows user to speak through the camera.

Enable Audio Output

Depending on camera design, streams live audio from the camera.

Chapter 1
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Procedure

Network Tab - Identify a New Network Camera
Task 1: Name a new network camera:

1. Inthe Name field, enter an appropriate and easily identifiable name for the camera.

2. Inthe Description field, enter an easily identifiable description. For example, “Camera near front
door.”

3. (Optional) In the ID/Code field, enter the code or identification you are using to classify and easily
identify your cameras.

Task 2: Locate the camera on the network

1. Enteran IP addressin the URL field or click Discover Devices to locate devices (the IP address) on
the network. The Discover Devices dialog box opens displaying a device tree.

2. Expand the brand name to see a list of devices.

3. Right-click on a device and select Connect to Symphony. The IP address of the device is now
displayed in the URL field.

4. Enter a Username and Password for the device. (This may be automatically displayed.)

Task 3: Automatically or Manually determine the device specifications:

Automatically:

1. Click Connectto Camera. The Camera Type and values for Resolution, FPS and Video Format are
automatically detected and displayed.

Manually:
1. From the Manufacturer list, select the brand or manufacturer of the camera.

2. Select the Camera Type, and set the Resolution, FPS and Video Format appropriately.

Task 4: Specify Failover Movability

1. From the Failover Movability drop-down list, specify whether the device will automatically move
to a redundant server under a failover condition.

¢ If set to Movable, then this device can move to another server in the farm during failover.

e If setto Unmovable, then the device cannot be moved. Any device that requires access
to resources available only on a single server (for example, COM port, special SDK or
drivers) is unmovable. All others are typically movable.

19
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Chapter 1

Procedure

Video Tab - Configure Advanced Features
To configure advanced features:

1. Click the Video tab. From the Record Video and Record Audio lists, select a condition or schedule
when Symphony should record video and audio on a specific camera. For options, see Table 2,
"Conditions under which video is recorded," on page 21 and Table 3, "Conditions under which audio
is recorded," on page 22. The options are available only if Symphony has detected that a recording

feature is supported by your camera.

2. By default, video is recorded 15 seconds before and after an event. You can adjust this amount by

entering a value in seconds in the Pre Event and Post Event fields.

3. The Change Frame Rate On Alarm option is available only if Symphony has detected this feature

is supported by your camera.

Metwork  Video |Ana|y‘tics Engines l Analytics Confiquration

Recording
R ERYL NN S chedule & Mation Detected By

Pre Event |15 seconds

[ Change frame rate on alarm to FP=

Widen Quality kilobitzfzec: [300

Mizc

Add & Merwy Stream

-

Rotate Degrees |0 -
Maximum Locked Minutes |5

Panoramic Settings

[ Enable panoramic technaology

Set Schedule

Post Event |15 seconds

Key frame interval. |25

Figure 3. Video tab

Chapter 1
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Chapter 1

Table 2. Conditions under which video is recorded

Option Available for Symphony records video...
Always All video cameras For this specific camera
On the schedule you specify.

1. Click Set Schedule. The Schedule dialog box opens.

2. Bydefault, the Do not record option is selected. Using your mouse, click on
the date and time intervals you do NOT want video recorded (green) and
click OK.

¢  You can set recording schedules to per minute ranges. Click on at least two
squares in one column. Hover your mouse over the first square or the last
square in the column (earliest or latest hour interval). Arrow range buttons
appear. Click the arrows to change times to per minute ranges.

Schedule @1
Sun | Mo Tue | Wed | Thu Fri Sat |Creste new scheduie =l
T2 N N I R N N [5crcoic
L Reset Wiewy Exceptions...
2iM
" Record |
Schedule All video cameras ipatneen

Schedule used by

Figure 4. Recording schedule

Schedule and
Motion Detected
by PC

When motion detection
video engine also
selected

On motion but only during the time period you specify.

Tracked Motion
Detected by PC

When motion detection
video engine also
selected

If objects are tracked through the scene (for example, a person or vehicle moving
through the scene is tracked as motion, but moving tree branches should not be
tracked and therefore video would not be recorded)

Pixel Changes
Detected by PC

When motion detection
video engine also
selected

Whenever pixel changes are detected.
Note: A tree moving in a heavy wind could cause pixel changes and therefore cause
Symphony to record video

Chapter 1
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Chapter 1

Table 2. Conditions under which video is recorded (Continued)

Option Available for Symphony records video...
. . Using motion detection capabilities inside the network camera itself, and not using
Motion Detected |Cameras which support . . . . . . L
. . a video analytic engine from Symphony (quality of motion detection similar to
by Camera Motion Detection .
Pixel Changes)
Schedule & . Records if motion detected during a specific time interval as defined by user.

. Cameras which support . . . e e . .
Motion Detected Motion Detection Using motion detection capabilities inside the network camera itself, and not using
by Camera a video analytic engine from Symphony
Never All video cameras Never records video unless specified to be recorded in a Rule

Table 3. Conditions under which audio is recorded
Option Symphony records audio...
Never Never records audio unless specified to be recorded in a Rule

Same as video

Records audio based on the video record settings in Table 2

Rule Broken

Records audio only when an alarm is triggered

Misc group box:

4. To add another video stream for the current network device, click Add a new Stream.

If the network device allows additional network video streams, the streams can be added

from the same physical device. Useful when one video is defined for recording and
another for live video.

The video recording options available are the same as defined by the default stream
(Table 2 on page 21). Video resolution can also be defined independently for the
additional stream(s).

5. To rotate the picture, select a value from the Rotate Degrees field.

6. Ifyou are using a PTZ camera, select a value in the Maximum Locked Minutes field to specify how
long a PTZ camera should remain in its current position before it returns to its preset (Home
Position).

Panoramic Settings group box:

7. Only for 360-degree camera lenses. To de-warp 360-degree video, select the Enable panoramic
technology check box. From the drop-down lists, select the camera brand and a Position (wall,
ceiling, ground) for how the camera is mounted.

8. Click Apply to save your settings and move onto the Analytics Configuration tab, or click OK to
save settings and close the dialog without configuring the selected video analytics engines (default

configuration settings will be used).

Chapter 1
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Procedure

Digital I/O Tab
For Axis cameras with digital 1/0, the Digital I/O tab appears.

{2 Rules Server Ilocalhos‘t =
EH-3] Devices
-85 1) Cameral etweark | Wideo | Digital 110 | Pnalytics Engines |
-T0F 20 CameraZ
.5 3) Camerad Mame ICamera?
- TEF 4 Camerad Descrimionl
- 5 Cameras |D.l'CDdE| —]
- TBE &) Camerat
“_1? D7) HardwareDevicel N
= URL [10.234.2248

..[4] Licenses £.0. 10.1.2.3 {port 50)
) MotiFications 10.1.2,3:120
: rkspeff10.1.2,3/mpeg4/1/media. amp (port 554)
A rtspifjuseripassword@10.1.2, 3t 1666 capture
[5h{=] Storage
E| localhost Manufacturer  |EACT i’
== Arecont
J_ﬂ Server Farm
- Climnb CARReekivibe _nn.-.l.-.. ; AXIS 01921

Figure 5. Adding an Axis Camera with Digital 1/0
invokes a Digital 1/0 tab in the Server Configuration dialog box
1. Click the Digital I/O tab.
2. (Optional) You can change the input and output names by clicking on each row and typing new text.

3. Select the In Use check boxes for each I/0 as necessary.

@ Rules Server Ilocalhos‘t j
87 Devices .
ﬂ@g 1) Cameral Netwrork | Wideo  Digital 110
- 7 CameraZ
T 3 Camerald Input 1
- 4 Camerad .
L
-0 &) Cameral
- THE 6 Cametat
rji 07} HardwareDevicel
A Cameral
[ 4] Licenses
Q] Matifications
-(T1) General Settings
5= Storage
L [H localhost
Server Farm
- Client Connectivity
-{&] Carousels

Analytics Engines |

Input Name Cutpuk Marne

Figure 6. Digital 1/0 tab for Axis Cameras in Server Configuration dialog box

4. Activate (or deactivate) each Output for the Axis camera as necessary in the Camera Tree dialog
box.
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Figure 7. Axis Camera I/O

Rules in Symphony for Cameras with Digital I/O

Rules in Symphony define what Event constitutes an alarm in the real world (for example, a perimeter breach
or even suspicious behavior around a car) and what Action to take after an alarm is raised (for example,
whether to send a security guard to the location in question).

Alarm inputs include Video Motion Detection from network cameras and external I/O devices. To set up rules
for I/0 devices, see the Rules section in the Aimetis Symphony Analytics and Rules Guide.

Procedure;

Analytics Engines and Analytics Configuration Tabs - Add Video Engines

By selecting the Analytics Engines tab, individual video analytics engines can be added to each camera. An
Enterprise license is required to enable video engines in the Analytics Engines tab. This step is necessary only
if video analytics are to be configured on this camera.

e  For information on how to configure and select the video analytic engines, see the Aimetis
Symphony Analytics and Rules Guide

e Forinformation on licensing, see “Symphony Server Licensing” on page 6
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Device - Analog Cameras

Analog cameras can be connected to Symphony in two ways:

Easy method: Use a video server (a network device that converts analog video to digital video). In
this scenario, Symphony connects to the video server the same way it connects to a network
camera; therefore, follow the steps in “Network Tab - Identify a New Network Camera” on page
19.

Connect an analog camera directly to Symphony. Follow steps in “To add an Analog Camera
directory to the server:"

A video capture card must be installed in the server itself. (Ensure that the video capture card is
supported by Symphony. See http://www.aimetis.com/Support/supported-video-devices.aspx).

Note: Connected using either Winnov Videum 4400 VO or HikVision DS-42xx
compression cards.

Procedure

To add an Analog Camera directory to the server:

1.
2.

Ensure that a capture card is installed in the server.

From the Server menu, select Configuration. The Configuration dialog box appears with Devices
displayed in the right pane.

In the right pane, click the arrow beside the New button. Select Add an Analog Camera. The
Analog tab appears.

On the Analog tab, you can modify basic configuration for the camera. See Table 4.

Table 4. Basic configuration for analog camera

Field

Task

Device

Select the available channel on the capture card

Name

Enter the name of the camera (for example, Lobby Camera)

Resolution

Configure the resolution of the input

FPS

Configure the frames per second to record video

Video Format Configure the video format, such as MJPEG or MPEG-4

PTZ Camera

Select this option if the channel in the Device field is connected to an analog PTZ
camera. You must also configure additional information such as:
¢ Type (denotes the type of analog PTZ camera)

e Camera Address (denotes which address the PTZ camera is configured),
e Control Port (denotes which COM port the serial adapter used to send and receive
control signals to camera is connected)

5.

Chapter 1

Configure the Video tab as per instructions in “Video Tab - Configure Advanced Features” on page
20. And configure the Analytics tab as per instructions in “Analytics Engines and Analytics
Configuration Tabs - Add Video Engines” on page 24.
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Device - 1/O

Input/output, or I/0, refers to the communication between an information processing system (such as a
computer running Symphony), and the outside world (possibly a human, or another information processing
system such as an access control system).

Inputs are the signals or data received by Symphony, and outputs are the signals or data sent from it.
¢ Symphony supports ADAM, Phoenix, Axis Camera I/O, and PSA devices. For a complete list of
support I/0 devices, visit http://aimetis.com/Support/supported-video-devices.aspx
e  For ADAM devices, see the Knowledge Base article:
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10072
e For Gallagher and Axiom RBH, see the integration guides:
https://www.aimetis.com/xnet/Support/documentation.aspx

Alarm

Aimetis Symphony 1/0 Device

Access Panel

Figure 8. PC sends a signal through the LAN. The I/O device on the LAN receives the signal and then is
wired to an alarm in one input or an alarm panel in another input.

Procedure

To add and configure an I/O device:

1. From the Server menu, select Configuration. The Configuration dialog box appears with Devices
displayed in the right pane by default.

2. Intheright pane, click the arrow beside the New button. Select Add a Hardware Device and then
one a device. (The recommended device is the Advantech (Adam) 6060.)The HardwareDevice tab
appears for the device type selected.
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Figure 9. HardwareDevice tab - I/O for Phoenix Devices

3. Inthe Name field, enter a name you want to use for this device.
4. Depending on the I/O device type selected, various fields are displayed:

e |P address - If an IP-based I/0 device is configured, enter the IP Address of the device.

e Module - Select an Advantech model (6050, 6060, 6066) from the drop-down list.

e Registry Entry/Control Number - For Phoenix. Field populated by default.

e COM Port and Baud Rate - If an I/O device is connected to the serial connection of the
server, you must configure the COM Port address and Baud Rate properly.

5. From the Movability drop-down list, specify whether the device will automatically move to a
redundant server under a failover condition.
e Ifsetto Movable then this device can move to another server in the farm during failover.

e IfsettoUnmovable then the device cannot be moved. Any device that requires access to
resources available only on a single server (for example, COM port, special SDK or drivers)
is unmovable. All others are typically movable. For more information, see Server Farm.

6. Activate (or deactivate) each Output as necessary in the Camera Tree dialog box.
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Figure 10. Phoenix I/O displayed in Camera Tree dialog box

Rules in Symphony for I/O Devices

Rules in Symphony define what Event constitutes an alarm in the real world (for example, a perimeter breach or
even suspicious behavior around a car) and what Action to take after an alarm is raised (for example, whether
to send a security guard to the location in question).

Alarm inputs include Video Motion Detection from network cameras and external I/O devices. To set up rules for
1/0 devices, see the Rules section in the Aimetis Symphony Analytics and Rules Guide.

Chapter 1
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Control PTZ Camera Auxiliary Outputs
Symphony Client includes two buttons (Aux on) and (Aux off) on the PTZ Controls interface. You can use these
buttons to activate and deactivate auxiliary functions on the device, such as a wiper. The first button (Aux on)
can start the wiper. The second button (Aux off) can stop the wiper.
Enabling Control Buttons
By default, the control buttons are hidden in the PTZ Control interface.
Procedure
To enable Aux on and Aux off buttons in the PTZ Controls interface:

1. Edit the %appdata%\aimetis\acc.ini

2. Add the following parameter under [Main]:

EnablePTZButtons=True

3. Save the acc.ini file and restart Symphony Client for the changes to take effect.
Reconfiguring Control Buttons
The commands for the buttons can be reconfigured using the Manual Configuration Editor.
Procedure
How to reconfigure the Aux on and Aux off buttons:

1. Start Symphony Client.

2. From the Server menu, select Manual Configuration Editor.

3. Click Add a new setting... in the first row to activate the cells.

4. For the Aux on button, enter the following in the first row: Type=Camera, Section=PTZ, ID=<your

camera id>, Key=StartWiper, Value= ff01000900010b (example value).
5. For Aux off button, enter the following in the another row: Type=Camera, Section=PTZ, ID=<your
camera id>, Key=StopWiper, Value= ff01000b00010d (example value).

6. To confirm your entry, click the Action cell.

7. Click OK.
You can modify these settings any time. Simply find the Camera ID and look for the StartWiper or StopWiper
values under the Key column.
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Managing Security Profiles

All user-access rights are defined in Groups in User Configuration.

e Each Group can have more than one Security Profile. Security profiles allow administrators to
change security privileges quickly depending on the situation.

e By default, only one Security Profile (called Default) is used. In most cases this will be sufficient.

¢ Insome cases it may be useful to define additional security profiles and modify access rights of the
Group per profile. This allows you to quickly change permissions to resources (such as cameras) in
cases of an emergency. For example, under normal conditions a group of users may have access to
all cameras, but in an emergency situation access may be temporarily suspended with one security
group but given to another.

When the Security Profiles for a Farm is changed, all servers in the farm are
notified, as well as all clients connected to those servers. The farm will remain
in that security profile until the active security profile is changed again.

Procedure

To view Security Profiles:

e From the Server menu, select Security Profiles. The Security Profiles dialog box appears.

Security Profiles EI@

Switch Profiles | Manage Profiles |

Active Profile : Default

Select profile for activation

Apply Cancel

Figure 11. Security Profiles dialog box
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Adding and Activating Security Profiles

Procedure

To add a Security Profile:

From the Server menu, select Security Profiles. The Security Profiles dialog box appears
Click the Manage Profiles tab.

In the right pane, click Add.

Click the new field under the Name column and enter a name for the new profile.

Click the new field under the Description column and enter a description of the new profile.

o v kA W N oR

Click Apply to save changes and then Close.

To activate a Security Profile:

This will immediately affect user access rights.
1. From the Server menu, select Security Profiles. The Security Profiles dialog box appears
2. Inthe Switch Profiles tab, select the profile for activation.

3. Click Apply to save changes. A message appears indicating that the profile is active. Click Close.

Caution: Access rights are not defined in the Security Profiles dialog box. To
modify user permissions per Security Profile, configure the appropriate Group
in User Configuration.

Note: If the Security Profile is changed, remember to change the Profile back in
order to restore users to their default permissions.
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User Authentication

To connect to a server farm from Symphony Client, a user must be authenticated. Symphony supports two modes
of authentication:

e Symphony Security (which is the stand-alone method)
e Active Directory integrated method

Although the authentication mode can be changed, it is generally configured during the initial setup of the farm.

Symphony Security
Securty Mode

@ Symphony Security
Active Directory Integration
LDAP URL: Auto Discover
Example: LOAP://DC=aimetis, DC=com

Figure 12. Defining Security Mode during Setup Wizard

To review the Security Mode in the Setup Wizard, from the Start Menu, select
Aimetis, and then Setup Wizard. For details, see the Installation Guide.

Symphony Security Authentication Mode

When the authentication mode is set to Symphony Security, the credentials (user name and password) are
stored in the Symphony database. The password is encrypted for security. When a user attempts to log in, the
credentials are compared to the credentials in the Symphony database, and a successful match allows the user
to log in. This is the default method and requires no additional configuration.

Active Directory Authentication Mode

Active Directory integrated mode uses Windows user passwords and as a result, users are not required to
remember and maintain different passwords, even if the Windows password changes. Additionally, IT managers
do not carry the additional burden of managing users in different applications. If a Windows user account is
disabled, that user will not be allowed to log on to Symphony.

When the authentication mode is set to Active Directory, the user name is stored in the Symphony database,
but not the password. Additionally, a mapping to the Active Directory user is stored (the Security Identifier, or
SID). When a user attempts to log on, the credentials are checked against Active Directory. If Active Directory
accepts the credentials, the user is allowed to log on.

For Active Directory integrated mode to be used, Professional & Enterprise
licenses must be used. A Standard license will restrict access to this feature.

32
Chapter 1



Single Sign-On (SSO) Chapter 1

Single Sign-On (SSO)

Single Sign-On is designed to restrict users from using different PCs with the same user name. It is transparent to
the user; there are no specific messages associated with it. When registering to a new farm or editing an existing
farm having Windows Authentication selected, the following message is displayed in case of failure: Windows
Authentication Failed. You must enter the user and the password.

SSO works alongside the current/existing Symphony authentication process. Windows authentication is more
secure than Symphony authentication; it makes use of the built-in Windows security system. Communication
between client and server is made through a WSE 3.0 SOAP Web Service.

Important: If users need their registered farms available on any machine on the

Symphony does not support cross-domain authentication for SSO.

| domain, they must enable roaming user profile (Windows).

SSO is designed to restrict users from using different PCs with the same user
name; however, a user may inadvertently log on multiple times on the same PC.

Process Flow

1. When Symphony Client connects to a farm, it creates a security token, based on the identity of the
currently logged-in Windows user; the user MUST have logged-in on the domain account.
2. The security token is sent to the farm/server for authentication.
3. Farm/server verifies that the token is valid and determines the domain account associated with it.
4. Upon success, farm/server sends a session ID back to the client.
5. Onfailure, the client’s farm state changes to Unauthorized.
6. In case of failure, the user can login using Symphony credentials:
a. In Symphony Client, right-click your farm in Server List.
b. Select Edit. The Server Login Information dialog box opens.
c. Disable single sign-on: clear the Windows Authentication check box.
d. Click OK.
e. Enter user name and password.
Important: Multiple Symphony Clients on a single Windows login (each
* registered with a different user) are needed to run Live Ban. As such, Single
Sign On will not be available for Video Walls when also running Live Ban.

Prerequisites

The Single Sign On feature uses the client’s domain identity to authenticate to the server; therefore, the client
and the server must be in the same security realm. As such, the Single Sign On feature is available only when:

Client and server machines are logged on to the same domain, and

The user logs on to the client machine as a domain user by using the domain credentials. (A user
can log on to a machine locally in which case the Single Sign On feature is not available.)

On domains controlled by Windows Server 2008 (or later) and clients running Vista/Windows 7:

Chapter 1

AES256_HMAC_SHA1 encryption must be disabled because it cannot be handled by the WSE 3.0
used by Single Sign On. This policy must be enforced by the domain controller and must be set by
the IT personnel in charge of the domain.
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Enabling Single Sign-On (SSO)

“Task 1: In Symphony Client (or manually) enable single-sign on”

“Task 2: In Symphony Client, change the storage path for the farm registration to a network

server” on page 36

Task 1: In Symphony Client (or manually) enable single-sign on

Procedure

To enable or disable single sign-on in Symphony Client:

Chapter 1

1.
2.

3.

In Symphony Client, right-click your farm in the Server List.

Select Edit. The Server Login Information dialog box opens.

e To enable single sign-on, select the Windows Authentication check box.

¢ To disable single sign-on, clear the Windows Authentication check box.

Click OK.

Update Server Information

Symphony Server Information

Address localhost

MName [¥wonne]

Symphony Server Login Information

@ndowshuthenticaﬁon v _)

User |

Paszword |

The location of the camera server.
There are 3 types of names allowed:

1) IP eg 45.23.23.43

2) DNS eg yourcompany.com

3) Aimetis eg [Honda Camera Server 1]

Aimetis names need to first be registered from the camera.
They are useful in cases where the client has a dynamic [P

The name by which youwant to refer to this server.

Your username setup on the camera server to allow access.

The associated password.

QK | Cancel

Figure 13. Windows Authentication check box
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Procedure

To enable single sign-on manually:
1. Edit %APPDATA%\aimetis\RegisteredFarms.xml.

Example:
<RegisteredFarms>
<Farm ID="74083">

<Encryption>6.2</Encryption>
<Alias>10.234.10.76</Alias>
<SpecifiedAddress>10.234.10.76</SpecifiedAddress>
<UserName>MVYITEIRRUhQ</UserName>
<Password>kjdflasdkjflakj</Password>

<UseWindowsAuthentication>false </UseWindowsAuthentication>

<Addresses>
<Address>
<SpecifiedAddress>10.222.10.73</SpecifiedAddress>

<IP>10.222.10.73</IP>
<Port>50001</Port>
</Address>
</Addresses>
</Farm>
</RegisteredFarms>
2. Under <Farm ID = “number” >,

¢ To enable single sign-on set
<UseWindowsAuthentication>true </UseWindowsAuthentication>

e To disable single sign-on set
<UseWindowsAuthentication>false </UseWindowsAuthentication

Chapter 1
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Task 2: In Symphony Client, change the storage path for the farm registration
to a network server

Procedure

To ensure that farm registration information is stored on a network server:
1. From the View menu, select Settings. The Symphony Client Settings dialog box opens.

2. Click the Global tab.

Symphony Client Settings = @
Startup| Display | alarms | video| Camera Wiew | Maps | Sound | Regional | User Settingsl Global |L0ck| Update| Advanced |

Any changes on this tab will affect all users on this computer,

Path to client configuration:

|Crisers| 2 WINUISER % AppData\Roamingl Aimetis |

[ Custom path ta Farm registration
CiiUsers) SWINUSER %\ AppDatatRoaming' aimetis
Use %WINUSER S to use Windows username in path,

Use %SYMPHONYIUSER % to use Symphony username in path,
[Mate: Symphony username is only applicable if Symphony login is required]

| [0]4 | | Cancel

Figure 14. Global tab in the Symphony Client Settings dialog box

3. Select the Custom path to farm registration check box.

4. Inthe next field enter the path on the network where the registration information will be stored for
all roaming users.

e The network server storing all the farm registrations must be accessible from all Clients.
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e This is a global setting. All users that login to this Client will use this setting. Use the
%WINUSER% variable when configuring this path so that each user has a unique path
where the farm registration is stored. The user must have Windows “modify” rights to
this folder. This is set only once on each Client machine.

Important: It is a security risk to have multiple users share a farm registration.

Chapter 1

Symphony Client Settings = @
Startup| Display | alarms | video| Camera Wiew | Maps | Sound | Regional | User Settingsl Global |L0ck| Update| Advanced |

Any changes on this tab will affect all users on this computer,

Path to client configuration:

|Criisers| 2 WINUISER % AppData\Roamingl Aimetis |

[¥] Custom path to farm registration

|\\INEFWORK_SER\|’ER DW= AppData \Roaming \Aimetis |

Use %WINUSER S to use Windows username in path,
Use %SYMPHONYIUSER % to use Symphony username in path,
[Mate: Symphony username is only applicable if Symphony login is required]

| [0]4 | | Cancel |

Figure 15. Changing where farm registration information is stored
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Configuring User Access

Groups and Users are managed in the User Configuration dialog box.

Users can be created, modified, and deleted from the User Configuration dialog box in Symphony Client. Several
properties for a user that can be changed, including user name, password, and description.

Procedure

To view User Configuration:

e From the Server menu, select User Configuration. The User Configuration dialog box opens.

User Configuration - 10.234.1.34 o=
o TomHil Vewgser
Mame Email Fhone Description Disabled Last Login Time
b TomHill | | | | | [s/20/2010 10:18...

view All Users

New User

Administrators
Symphony Users

iew All Groups

Mew Group

oK App Cancel

Figure 16. User Configuration dialog box

The Users section in the left pane summarizes a list of users on the system. The color of the button beside each
user indicates the status of the user:

e green for logged on
¢ red for disabled
e grey for logged off

The Groups section in the lower left pane summarizes all security groups in Symphony.
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Understanding User Groups
The user management system in Symphony employs user groups. This allows administrators to organize the
security privileges of users as part of Groups. The administrator establishes group security privileges and then
assigns users to groups.
¢ An administrator can create, rename, and delete groups, as well as modify group membership.
e Agroup may contain users or even other groups.
¢ Both a user and a group may be in multiple groups.
(Not allowed: Group A is part of Group B, which is part of Group A.)
By default, there are two User Groups.
e The Administrators user group allows users who are a member of this group full access to the
system.
e The Symphony Users group allows users limited access.
Group membership makes the security management of many users easier than managing privileges on a per user
basis.
e If a security restriction is applied to a group, this restriction is implicitly applied to all members of
that group.
e If users are added to the group at a later date, the same security restrictions automatically apply.
e If users are removed, the security restrictions no longer apply.
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Procedure

To view an existing User Group:

e From the Groups section, select the name of the group. The Group Information is displayed in the

right pane.
User Configuration - 10234134 e = E ==
@ Tom Hill |"Group Tnformation
Group Mame qbymphony Users ) |
—
Description |Defau|t group to which new Symphony users are added |
Members
View All Users | Add Member | | Remove Member |
Mew User
Remove User Member OF
Administrato
Symphony Users
S
| oin Group | | Leave Group |
Security | Manage Security |
s ~
- View All Groups )
Mew Group
Remove Group
oK Apply Cancel

Figure 17. Group Information

Adding a New User to a Group

Procedure

To add a new User to a Group:

1. From the Groups section, select the name of the group. The Group Information is displayed in the
right pane.

2. Click Add Member. The User/Group Selection dialog box opens.
3. Select a user name and click OK.

4. Click Apply.
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Making a Group a Member of Another Group

Procedure

To make a Group a member of another Group:

1. From the Groups section, select the name of the group. The Group Information is displayed in the
right pane.

2. Click Join Group. The User/Group Selection dialog box opens.
3. Select a group name and click OK.

4. Click Apply.

Modifying Access Rights for a Group

Security rights will be defined at a resource (for example, camera) level within the group. Rights may include the
ability to view a camera, to use the PTZ, or to change camera settings. Permissions to access these rights can be
associated with users and/or user groups by an administrator.

User Configuration - 10234134 e = E ==
e

Group Mame qbymphony Users ) |
| —
Description Default group to which new Symphony users are added
Members
View All Users Add Member | | Remove Member
Mew User
Tl Member Of <All Users>
Administrato
Symphony Users
—
Security | Manage Security |
o -
- View All Groups )

Mew Group

Remove Group

oK Apply Cancel

Figure 18. Manage Security

Chapter 1
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Procedure

To modify access rights for a Group:

1. From the Groups section, select the name of the group. The Group Information is displayed in the
right pane.

2. Click Manage Security. The Security Configuration dialog box opens.

3. From the Security Profiles drop-down box, select the profile for which you want to modify
privileges. (For background information, see “Managing Security Profiles” on page 30.)

Security Configuration EI@
@”W Profiles  [Defauit = |) - for example, Emergency Profile

Farm | Devices | Video Walls | Users |

Right Description Allow Deny Unspedfied Effective Permission -
Connect Connect to the farm (-] @ Q) Allow I
Get Logs Get log files and other information ® (@] @ Allow

Manage Services Perform service management (e.g. stop, restart) & & @ Allow

Change IO State Change the IO state of a device F F @ Allow

Figure 19. Selecting a Security Profile

4. Select the Allow, Deny, or Unspecified option for each Right (see Figure 20 on page 43).

e Farm tab defines access rights for core functionality that is not specific to a camera or
other resource; for example, whether a user can connect to the farm, or export video.

e Devices tab defines user permissions that can be defined for device; for example,
whether a user can view the live feed or change the configuration for a specified camera,
or listen to a camera or talk through a camera

e Video Walls tab defines user permissions that can be defined for video walls; for
example, whether a user can move a window in the video wall, or edit a video wall layout.

e Users tab defines user permissions that can be defined for other users; for example,
whether a user can view or edit the properties of another user or group.

e The Effective Permission column calculates the access granted this group for the current
functionality. Symphony checks if this group is a member of another group that may
restrict access to the resource. For example if the current group allows access but another
group of which it is a member restricts access, the effective permission will be Deny.

5. Click Apply to save changes and then Close.
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B Security tonﬁgulaf;on .
Security Profiles  [Default

| Farm | Devices | Video Walls | Users |

Right Description Allow Deny Unspedified Effective Permission -
Connect Connect to the farm Allow I
Get Logs Get log files and other information (@] Allow

Manage Services Perform service management (e.g. stop, restart) Allow

Change IO State Change the IO state of a device Allow

Flay Sounds Play sounds on a server Allow

Delete Footage Delete camera footage Allow

Export Video Export video Allow

Manage Bookmarks Create, edit and delete bookmarks Allow

Configure Maps Create, edit and delete maps Allow

Change Settings Change general settings Allow .
Add Devices Add a new device Allow 1
Change Access Control Change access control Allow

Change Authentication Mode Change the authentication mode Allow

Manage Security Profiles Manage (edit/add remove) security profiles Allow

Activate Security Profile Change the active security profile Allow

View Subscriptions View subscriptions Allow

Change Subscriptions Change subscriptions Allow

Search Perform search Allow

Delete Searches Delete searches Allow

Convert Searches Convert searches to other formats Allow i
Execute Report Execute reports Allow

View Alarms View alarms Allow

Mark Alarms Mark alarms Allow

Manage Alarms Enable or disable alarms Allow

Add Alarm Add an instance of an alarm Allow

View Rules View rules Allow

Change Rules Change rules Allow

Backup Backup data andor configuration ® Allow =

oK Apply I Cancel

Figure 20

. Security Permissions

You can click on the effective permission entry for a given right to display a list of inherited permissions. This helps
you determine which group membership is causing the current effective permission.

Right Description Allow Deny Unspedfied Effective Permission

Basic Access Know the device exists Ao ~
Change Settings Change device settings Principal Permission Right Resource

Delete Delete the device Administrators | Allow |Basic Access <Al Devices
View Live Video View live video from the device

View Historical Video View historical video from the device

Search Footage Search footage from the device

Control PTZ Control the pan, tilt, and zoom of the device (if supported)

Manage Alarms Enable/disable alarms caused by the device

Manage Recording Startfstop recording on the device

Configure Analytics Configure analytics on the device

Edit Device Security Modify the security settings related to the device

Edit Membership Modify which groups the device is a member of (&) E @1

Figure 21. View inherited permissions
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Users within Groups and Effective Permissions
Users can be assigned individual security privileges if necessary.
The Deny option for any individual user or group overrides Allow.
e If at any point there is an explicit Deny permission defined between a user/group and the
resource/group, permission will be denied.
e If there are no explicit Allow or Deny permissions, permission will be denied.
e If no explicit Deny permissions exist, but there is at least one Allow permission, permission will be
allowed.
Example 1
User A has individual right of Allow, belongs to Group 1 which also has Allow, but is a sub
group of Group 2, which has Deny. User A will be Denied the right.
User B has individual right of Deny, belongs to Group 1 which has Allow and is a subgroup
of Group 2, which has Allow. User B will be Denied the right, irrespective of the group
designations (of Allow). Deny is always the effective overriding permission.
Associating Groups with Active Directory
When the Active Directory authentication is enabled, groups can be optionally associated with Active
Directory groups. Associating groups with Active Directory may be beneficial in large organizations with an
existing Active Directory hierarchy. Once the associations have been defined, Symphony is periodically
synchronized with Active Directory to ensure that the group relationships are equivalent.
Procedure
To associate a group with Active Directory groups:
1. Inthe Group Information dialog box, click the Associate button. The Active Directory Search
dialog box opens.
Jeeurity | Manage Security |
Active Directory |S-1-5—21-?583?45?1-456630852—285918446?—1346
] =
Figure 22. Active Directory options
2. Use the search feature to find and select the Active Directory group to associate. If groups are
associated with Active Directory, group membership is automatically synchronized.
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Ban Live Video

Allows you to ban video from cameras and camera groups. Only users and groups with specified permissions
can use this feature. You must set up all server machines for this feature.

Procedure

To create a User Ban Group:
1. Create a group named UserBanGroup. To this new group, add the following users:

e All non-admin users that should be banned from selected devices during a video ban.

e Users who log into video wall clients. This is so that video wall clients are properly
banned.

2. Add this group to database settings table:

a. From the Server menu, select Manual Configuration Editor.
b. Click Add a new setting in the first row to activate the cells.
c. Enter the following in cells under each column:

Type=Global
Section=Main
ID=<empty>
Key=LiveBanGroup,
Value= UserBanGroup

anfiguration

Mote, certain setting changes require services to be manually restarted,

~Settings
Type &
i | ID A
Type iy Section hin] iy Key Value Ackion
1 | Global MMain LiveBanGroup

[H Type: Camera
[ Type: Dio
@ Type: Global

[H Type: Server

Refresh Al | glese |

3. To confirm your entry, click the Action cell.

4. Click OK.
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Managing Users

Users are managed from the User Configuration dialog box. The following information is stored about a user:

¢ Name, password, email, phone, description

e  Priority (higher priority has control of PTZ camera) PTZ priority and rule management is configured
on a per-user basis, not through Groups.

e  Type of User
e Symphony (basic user with customized restrictions)
e Administrator (advanced user with customized restrictions)

e Membership in Group (must be a member of at least one group). The security permissions for
each user are defined through its Group membership.

User Configuration - 10.234.1.34 EI@
User Name | Tom Hill | i
Password | “““ |
Name | |
Email | |
Phone | |
Description | |
Disabled ]

New User
o ———— Bty low | High
Administrators = ' ' ' ' ' ' ' ' ' ' =

Symphony Users

Type of User

Priority is used to decide between users when there is competition for a
resource (eg two people want to use a PTZ camera at the same time).

|Adminishahor |

| | Make Mon-Administrator

Member of Administrators

| Join Group | | Leave Group |

BRI ( Manage Security ) | e

Figure 23. User Configuration dialog box
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Procedure

To set up a new user:
1. From the Server menu, select User Configuration. The User Configuration dialog box opens.

2. Inthe left pane, click New User. The User Information dialog box opens. By default, the new user
is a member of Symphony Users and is designated as a Symphony User Type.

3. Enter information about the user such as User Name and Password.

4. Click Apply.

Note: If Active Directory mode was defined during setup, no password is stored
in Symphony as the Windows domain password will be used.

5. Define the rules for which the user will receive alarms:

By default, the user receives all alarm notifications configured for that user. In some cases,
however, users may not want to receive alarms for particular rules, despite having access to
the camera.

a. Click Manage Rules. The Rule Configuration dialog box opens.

b. Select or clear the rule check boxes as necessary and click Ok.

6. Using the Priority slider in the middle of the dialog box, assign High or Low priority access for your
user. For example, a user with higher priority gets control of PTZ camera when two users want to
access the camera.

7. To define access rights for this user, select the appropriate group in the Member Of section.

8. Click Apply to save changes and then Close.

If you upgraded from Symphony v6.2 to v6.7, note that the Priority slider
settings for PTZ control is now very simple. Users with a high priority should be
set to High. Users with a low priority should be set to Low.

Active Directory Authentication

When Active Directory authentication is enabled, each user in Symphony must have a corresponding Active
Directory user. The Check Active Directory button is enabled only when Active Directory authentication was
enabled in the Setup Wizard (see Installation Guide). When the Check Active Directory button is clicked,
Symphony attempts to find the closest match to the text currently typed into the User Name field.
e If there is only one match, the User Name, Name, and Description fields will be populated from
the corresponding fields in Active Directory.
e If there are no matches, or multiple matches, the Active Directory Search dialog box will be
displayed. This allows you to find the appropriate Active Directory user to associate with the
Symphony user.

Chapter 1
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Supervisor Logon

Depending on your installation, Symphony can be configured to allow Supervisor Logons. This feature allows two
users to log on simultaneously in Symphony on the same PC, granting them higher user privileges than they
normally have on an individual basis. For example, users who are members of the Symphony Users Group may
have insufficient privileges to export video. But if they log on concurrently together in Supervisor mode they have
sufficient privileges to do so.

You must create a new virtual Supervisor User and a new User Group (for example, Power Users) which this user
will be a member of. The new User Group should have greater privileges than the Symphony User Group.

You cannot modify an existing user to have these supervisor privileges. Essentially, this virtual Supervisor User
name will work like a key to open (allow) certain privileges for two users logging on at the same time.

Setting up Supervisor Logon on Your System

e  “Task 1: Edit the acc.ini file for Supervisor Privileges and Reason field”

e  “Task 2: Set up a “Power Users” group for a virtual user for supervisor privileges:” on page 49
e  “Task 3: Set up a virtual user for supervisor privileges” on page 50

e  “Task 4: Define who can log on as the virtual supervisor user” on page 51

Using Supervisor Logon

e  “Logging on with Supervisor Privileges” on page 52
e “Understanding User Logins in View Detailed Events” on page 53
e  “User Logins Report - Notes Column Indicates Supervisor Login Reason” on page 53

Task 1: Edit the acc.ini file for Supervisor Privileges and Reason field
1. Close Symphony Client.
2. Edit %appdata%\aimetis\acc.ini file.
3. To display the Supervisor Logon feature:
e Under [Main], add ShowTwoManRule=True

4. (Optional) By default, the Reason field is displayed when the Supervisor Logon feature is activated
and the user must include a reason for logging on.
To suppress the Reason field requirement:

e Under [Main], add TwoManRuleReasonIlsMandatory=False

48
Chapter 1



Using Supervisor Logon Chapter 1
Task 2. Set up a “Power Users” group for a virtual user for supervisor
privileges:

1. From the Server menu, select User Configuration. The User Configuration dialog box opens.

2. Inthe left pane, click New Group. The Group Information dialog box opens. Create a group that
the virtual supervisor user will belong to, for example, a “Power Users” group containing high
privileges.

3. Ensure that this group has higher privileges than the regular Symphony Users group.

4. Click Apply to save changes.

User Configuration EI@'
© First Liser
@ Second User
0 Securityl
© Supervisor Made User Group Narme Power Users
Description High privileges
Members
Add Member | | Remove Member
Member OF Symphany Users
View All Users |
Figure 24. New “Power Users” group
For added security, ensure that the Change Settings permission for the “Power Users” group is set to Deny. As
such, when two users log on together, they will NOT be able to change their account permissions and make
themselves Admin users. (Click the Manage Security button in the User Configuration/Group Information
dialog box.)
E Security Configuration - Power Users !E[ E
Security Profiles  Default -
i Devices | Wideo Walls | Users|
Right # | Description | Allow | Deny | Unspecified  |Effective Permission IL
Activate Security Profile Change the active security profile o] o] ® Dery
Add Alarm Add an instance of an alarm o] o] ® Dery
Add Devices Add & new device o] o] ® Dery
Add or Edit License Plate Metadata Edit the description and additional details about a license plate or... o] o] ® Deny
Add Users Add new users and groups o] o] ® Dery
Backup Backup data and/or configuration o] o] ® Dery
Change Access Control Change access control o] o] ® Dery
Change Authentication Mode Change the authentication mode o] o] ® Dery
Change Carousels Change carousels o] o] ® Al
Change I State Change the IO state of a device o] o] ® Dery
Change Rules Change rules o] o] ® Dery
Change Settings Change general settings (o] (o] ® Deny
Change Subscriptions Change subscriptions o] o] ® Dery
Change Video Wall Client Register/Unregister current Symphony Client as Yideo Wall Client [e] [e] (0] Deny
Figure 25. Recommended: Change Settings permission set to Deny for “Power Users” group
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Task 3: Set up avirtual user for supervisor privileges

1. Inthe left pane, click New User. The User Information dialog box opens.

2. Enter a User Name and Password for the virtual user for Supervisor Logon. By default, this new

virtual user is a member of Symphony Users.

3. Jointhis user to the new “Power Users” group you created in “Task 2: Set up a “Power Users” group

for a virtual user for supervisor privileges:”.

a. Click Join Group. The User/Group Selection dialog opens.

b. Select the “Power Users” group and click OK.

4. Click Apply to save changes.

User Configuration EI@
[© Fist wser

User/Group Selection User Name |Supervisor Mode User |
Power Users
\_ Password |******** y, |
-
Mame | |
Ernail | |
Phone | |
Description | |
Disabled ] | |
Priority Low High

a PTZ camera at the same time),

Priority is used to decide between users when there is competition For a resource {eg two people want to use

|Symph0ny User

| Make Administrator | | Make Mon-Administrator

Symphony Users

K | | Cancel | ( Jain Group ) | Leave Group

-~ -

Figure 26. New virtual user must join “Power Users” group
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Task 4: Define who can log on as the virtual supervisor user
1. With the virtual new user dialog box still open, select the Supervisor check box.

2. From the drop-down list, select Symphony Users group (or any group that you want two members
to log in with Supervisor Mode). This allows two members of a Low Priority/Privileges Group to log
on as a virtual user, who is a member of a Higher Priority/Privileges Group.

3. Click Apply to save changes and then OK.

User Configuration - EI

@ firctlser User Information

@ Second User
W Securibyl User Nare |Supervisor Mode User |
& Supervisor Mode User
Password |******** |
Marme | |
Ernail | |
Phone | |
Description | |
Disabled [ | |
Rules Manage Rules
Priority Low High
View All Users : |
! . . . . . . . . |
Mew User
Priority is used to decide between users when there is competition For a resource {eg two people want to use
Remaove Lser | a PTZ camera at the same time),

Power Users

T F L Symphary L
Symphony Users VRCLESSED | yrphony User

I Make Administrator ‘ | Make Mon-Administrator

Member of

Symphony Users

| Jaoin Group I | Leave Group
Any 2 members of this group can log on together to impersonate this user \
Supetvisor [Syrmphorry Users A
Security I Manage Security
Yiew Al Groups j
MNew Group.
Remove Group
OF l Apply I Cancel

Figure 27. Supervisor check box
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Logging on with Supervisor Privileges

Procedure

To log on with supervisor privileges:
1. In Symphony Client, from the File menu, select Log On/Switch User. The Logon dialog box opens.

2. Select the Server to log on to with supervisor privileges. The Supervisor Logon check box appears.

SErver |l\.-1\,.' Sarver |V|

User
Password

[7] Windows Authentication

[ Supervisor Logon

| K | | Cancel

Figure 28. Logon

Enter the User and Password of one of the two users.
Select the Supervisor Logon check box. More fields appear.

Enter the User and Password of the second user wanting to log on at the same time.

AL

Enter the Supervisor User name. It is the same name of the virtual user you created in the User
Configuration dialog box. (See "Task 3: Set up a virtual user for supervisor privileges" on page 50.)
Essentially, this Supervisor User name works like a key to open (allow) certain privileges for the
two users logging on at the same time.

E Logon
Server My Server o
Liser
Password

O windows Authentication

Liser

Password

Supervisor User

Reason

| OK | | Cancel |

Figure 29. Supervisor Logon fields displayed
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7. Ifthe Reason text box is displayed, enter information that describes why you are logging in with
supervisor privileges. (An acc.ini file controls whether the Reason field is mandatory.)

8. Click OK. You can now use the system.

Understanding User Logins in View Detailed Events

In the Help>View Detailed Events dialog box, two users logged in with supervisor mode will have their
usernames joined by the underscore character.

Crag a column hea re to group by that column

|

119/2012 03:30:48 PM onfigurationChange 4016 UsEername Securityl

07/19/2012 03:30:48 PM ConfigurationChange 4016 Edited User

07}19/2012 03:30:48 PM ConfigurationChange 4016 Id o

0719/2012 03;30:48 PM ConfigurationChange 4016

07/19/2012 03:31:25 PM SessionEnded 4017 b77fca7a-9124-44f6-2a79-3... sessionld b77fra7a-9124-44F6-9a79-3

07}19/2012 03:31:25 PM SessionEnded

07/19(2012 023126 PM SessionCreated username First User_Second User

07/19/2012 03:31:26 PM SessionCreated t T t‘
07/19/2012 03:31:26 PM  SessioniCreated notes esting

Figure 30. View Detailed Events - Usernames joined by underscore indicates two users logged on
at same time to same machine

User Logins Report - Notes Column Indicates Supervisor Login Reason

In the Server>View Logins, User Logins dialog box, the Notes column contains the reason two users had
to log in at the same time.

User Logins [F=5 Eol 55
& Date Al Zilopiiolliphoad Rintind Bpotlo, g
-
Date Time Username P ‘ Motes ’
07f19/2012 02:47:03 PM Securityl 10.234.5.31 R
07j19f2012 02:51:07 PM First User_Second User testing
07/19(z2012 02:53:55 PM Securityl
07f19/2012 03:00:11 PM Security 1
,’.—,1_,' s E=mmeany it - -~
( 07192012 03131126 PM First, User_Second User Testing )
T A T i

Figure 31. User Logins showing Notes column
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Advanced Information - Active Directory Associations

Before reading this advanced level information, ensure that you have reviewed the information in the following

sections:

e  “User Authentication” on page 32

e “Configuring User Access” on page 38

e “Understanding User Groups” on page 39

Authentication Mode Set to Active Directory (in Installation Setup
Wizard)

When the authentication mode is set to Active Directory, Symphony users are tightly bound to their Active
Directory information.

e When creating a new user in Symphony, the user must have a corresponding Active Directory user
designation. (See “Active Directory Authentication” on page 47).

e Users with no Active Directory association cannot be authenticated. The user properties of
unassociated users, however, are still modifiable.

Synchronizing with Active Directory

On a periodic basis, certain user attributes are synchronized with Active Directory, and thus these properties
cannot be modified manually.

The following properties are synchronized with Active Directory:

e User Name, Full Name, and Description.

e Group membership except for Administrators. Users in the Administrator Group are only in the
Administrator group.

Important: Passwords are never stored in this mode, so they cannot be
modified.
Logging on to Symphony if your user does not exist in Symphony

¢ If authentication mode is Symphony, logon will fail because the credentials cannot be
authenticated.

e If authentication mode is Active Directory - after the credentials have been successfully
authenticated against Active Directory - a new Symphony user is created and associated with the
specified Active Directory user. This user is added to the Symphony Users group, and thus inherits
all security permissions from that group.

Groups Associated with Active Directory
When the authentication mode is set to Active Directory, groups can optionally be associated with Active
Directory groups. Groups with Active Directory associations have their group membership periodically
synchronized with Active Directory.
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Example 2
Symphony Group A is associated with Active Directory group 1
Symphony Group B is associated with Active Directory group 2
If group 1 is a member of group 2, then Symphony Group A will become a member of
Symphony Group B when group membership is synchronized.
Table 5. Restrictions on Symphony Groups
Symphony Group with
Active Directory
Membership Symphony Group Association
Member of another Symphony group Allowed Allowed
Member of another Active Directory group Not-allowed Allowed
Explicitly leave an Active Directory group Not-allowed
Explicitly join an Active Directory group Not-allowed
Periodic Synchronization
Periodically (daily, at 11:59 pm), Symphony is synchronized with Active Directory. The process is as follows:
1. User associations are verified and updated
a. For every Symphony user without an Active Directory association, we determine if
there is a matching Active Directory member (by comparing user name to Active
Directory account name).
e If there is a match we create an association between the two.
b. For every Symphony user with an Active Directory association, we verify that the
Active Directory member still exists.
¢ If not, we remove the association.
e |f the association exists, we ensure that the user name, full name, and
description in Symphony match the same values in Active Directory.
2.  Group membership is updated
a. For every Symphony user and group with an Active Directory association, we
determine the Active Directory group membership.
¢ If group membership has changed in Active Directory, then those changes are
applied to the Symphony Group membership. Any non-Active Directory
relationships are maintained.
For a visual representation of this process, see Figure 32 on page 56.
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Yes Create an association
between the two

Matching Active
Directory member?

Symphony user without

an Active Directory No action

No

Ensure that the user \
Active Directory name, full name, and
member still exists? Yi description in
Symphony matches the
same values in Active
Directory /

es
No h
Remove the
association
v

Yes

e | Changes are applied to the
Symphony Group

User associations
verified & updated

Symphony user with an
Active Directory

Symphony user and group
with an Active Directory
association

Group membership
has changed in Active
Directory?

Group membership
is updated

membership

No action

Figure 32. Synchronization Process

When a user joins another Active Directory group:
1. Any changes to Active Directory will not be detected immediately by Symphony.

2.  When the daily synchronization occurs, Symphony will detect that the user has joined a new Active
Directory group.

3. The server will then attempt to find a matching Symphony group.

e If a matching Symphony group exists, the user will be added to that group.

e If not, the server proceeds to recursively check all the parents of the Active Directory
group, trying to find a match with Symphony groups. The operation continues up each
parental line until either:

a. an associated Symphony group is found, or
b. there is no parent to check.

This operation ensures that the Symphony group membership matches the Active Directory group membership
as closely as possible.
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Using Maps

Symphony allows you to upload an image (jpg, gif or bmp file) to be used as a map (visual representation) of your
camera configuration. For basic usage, see the Aimetis Symphony Client User Guide. This section provides
instructions on more advanced features of Maps.

e  “lcons on Map"

e  “Adding Rules to Maps” on page 59

e  “Adding Digital Input and Output to Maps” on page 61

e  “Customizing Digital Input and Output Names” on page 63

e “Activating an Output Device Using the Map Context Menu” on page 65

Icons on Map

Use the following legend to understand the icons placed on maps.

Table 6. Map Icon Legend

Icon Icon Description Represents Colors Indicate

You can set colors to indicate various states as

Filled in circle Rule on a camera
. necessary

Digital Input

e.g., person presses .
(e-g., p .p Green arrow, white background - not
a button, which

Triangle pointing up in circle activated

I | causes an .
Mo . .. | Green arrow, yellow background - activated
appropriate actionin

the system)

Digital Output

. Green arrow, white background - not
(e.g., motion sensor

f oS Triangle pointing down in circle . activated
ik A detects motion and )
e Green arrow, yellow background - activated
closes a gate)
Green arrow - recording
Orange arrow - activity
c} Circle containing an arrow Camera Red arrow - alarm

Orange circle - camera currently selected

Green arrow - recording

Box around a circle containin Orange arrow - activity
g PTZ Camera Red arrow - alarm
an arrow

Orange circle - camera currently selected

Access control

Door device Green - access granted
(e.g., key card or key | Red - access denied
fob)

Chapter 1
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Map - Test Farm - Winslow House {ID: 3)

@& B Maps-~ o Edit Maps. ..

e

2p paD ENGLEED N
STERNHTT, MRCHITECT.

-t

Kitchen

PN
] 1)
L/

Living Room ]

FIRST FLOOR PLAN D

o & e
S &% RODERT E. FELIN
CHICACD PROJZET 1 1954 el T B EelT wmer o | istonic AMERICAH
: i WINSLOW RESIDENCE L BUILDINGS SURVEY
D STATER CEPIRTNENT 7 TR IHTERIR HE PLACE RIVER FORESY, ILLINOIS a1 s

Figure 33. Example of a typical map with camera, PTZ camera,
digital I/O, and control access device icons, and rules
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Adding Rules to Maps

Every Rule on Map must be associated with a camera or a device. The Rule on Map icon helps emphasize alarm
notification by either flashing for 10 seconds at every new alarm, or by flashing until security personnel mark the
alarms as real/false/actionable.

Because you can always create more than one rule for the same camera, with Rules on Maps, you can see exactly
which rule is triggered. The name of the rule is displayed when hovering over a map.

Any rule created for a server in the active server farm in the Rules Wizard will be listed in the Rules tab of the
Map Configuration dialog box. For more information on the creating rules, see the Aimetis Symphony Analytics

Guide.

A Rule can be used in the following ways:

Added to multiple maps.

Added to the same map more than once.
Moved to another location on the same map.
Removed from a map.

Alarms function as follows:

Only alarms that appear in the Alarm Log will appear on the map. (If you start the Symphony
Client and there are pre-existing unacknowledged alarms loaded, the map will display flashing
alarm icons (if this has been configured).

When you left-click on the rule icon, the Symphony Client will display the last unacknowledged
alarm JPEG for the associated camera (the first camera if there are multiple cameras).

A Rule on map reflects the current state, configurable by user:

Chapter 1

Option 1: Flashes if any alarms are unacknowledged; otherwise, remains invisible. Once you have
acknowledged all alarms (related to that rule), the rule disappears from the map.

Option 2: Flashes for 10 seconds when a new alarm occurs; otherwise, remains invisible
These options are available in the Maps tab of the Client Settings dialog box.

e From the View menu, select Settings. The Client Settings dialog box opens. Click the
Maps tab.
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5
|41 New Map 38 Delete Map [5 Changelmage _

o ]

Map
Fioor Plan
Desert e eu BB wopua el st can i s Rl
Winslow House

“ Drag items onto the map
| Rutes |pevics|

i |Lost Camera Connection
b tchen Alarm

.
i
T
!
!
1}

B o ||
= JTF” LR

=

FIRST FLOOR PLAN WD

W Fs WINSLOW RESIDENCE
e o

FYVERCHE IVER FOREST, (LLINOIS

OK Cancel
Figure 34. Rule on Map example
Procedure
To place rules on a map:
1. From the View menu, select Map Navigation.
2. Scroll through the maps to select the one which will have rules.
3. Inthe upper right corner of the Map dialog box, click Edit Maps. The Edit Maps dialog box opens.
4. Click the Rules tab. From the right pane listing the rules, drag and drop your rules to the map with
your mouse.
5. Click OK to save settings.
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Acknowledging Rules on Maps

Procedure

To acknowledge an alarm (rule on map):
1. From the View menu, select Alarm Log OR click the Alarm Log icon on the Menu Toolbar.
2. Right-click on the alarm you want to acknowledge.
3. Select an action to perform:

e Mark As Alarm - To mark as a real alarm.
e Mark as False Alarm - To mark as a false alarm.

e Mark as Real Actionable - To mark as real alarm that requires action, for example,
security staff should investigate the alarm.

Adding Digital Input and Output to Maps

Not on all devices. See list in Knowledge Base article: http://www.aimetis.com/Support/kbarticle.aspx?1D=10141

The Map Configuration dialog box contains a Devices tab, listing all cameras and digital input and output
devices. You can customize digital input and output names to help identify them.

Configuration dialog box for the digital I/O to be displayed, regardless of which

| Important: The Show Digital /0O option must be enabled in Device Tree
specific inputs/outputs are selected.

Icon Icon Description Represents Colors Indicate

Digital Input

e.g., person presses a .
ey . o L (e-8. p . P Green arrow up, white background =
Triangle pointing up in circle | button, which causes .

L4 ) . . not activated

o’ an appropriate action
in the system)

Green arrow up, yellow background

r‘} = activated
Digital Output
pe- g Triangle pointing down in (e.g., motion sensor Green arrow down, white
(¥ circle detects motion and background = not activated
= closes a gate)
p—y Green arrow down, yellow
(¥ background = activated
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Procedure
To place digital inputs/outputs on the Map:
1. From the View menu, select Map Navigation.
2. Scroll through the maps to select the one which will have rules.
3. Inthe upper right corner of the Map dialog box, click Edit Maps. The Edit Maps dialog box opens.
4. Click the Devices tab. From the right pane listing the devices, drag and drop the digital devices to
the map with your mouse.
5. Click OK to save settings.
I's 'Edit Maps
= Mew Map Delete Map E‘ Change Image _>|
| Map I u'l_./r_{'l ‘—t| Draq items onto the map
5 =i | | ———
Interior - House i | . 7 || Devices | Rules || Map Links |
Rue-1 = |\‘ -/E ||_ |
: J._._% 1 . LY l:l--ﬂ Devices
RuPT2 s u |‘_/ i_g' -5 1Y Cameral
Paris ] - l E‘L - TE 20 CameraZ
Rue Dauphine 1] /m & 3) Camerad
______p-.-:: - oy - TE 4 Camerad
EERsi) L/L R S s s ol -85 5 Cameras
\“-| - 6) Camerat
[ i |_|____§___|_| I I - 8) Camera?
; 8 === Input 1
ey Input 2
= rj" 71 HardwareDevicel
bd= Output 0
.= Cutput 1
b= QUL 2
b= Input 0
b= Input 1
e Inpt 2
T TSR SRR <
[ e — L |
o]4 | | Cancel
Figure 35. Digital I/0 on map displayed with arrow icons
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Customizing Digital Input and Output Names

Procedure

To customize digital input and output names:
1. For Hardware Device:

a. Right-click on a device in the Camera Tree, and select Setup. The HardwareDevice
panel opens in the Server Configuration dialog box.

)
(} Design
-0 2) Cameraz OFf ~
-G 3) Camerad on
--T0g 4) Camerad OFf
-0 5) Cameras OFf
-G 6) Camerad on
Eh 8) Camera? on =
: Deactivated
Deactivated
- G %) Camerad on
- & 101 Camerad Off
Bk 3 71 HardwareDevice!
Setup... ted
Change I0 State... ated
ki cestivated |
&

e Tk Y Furmmbis b

Figure 36. Camera Tree dialog box - Right-click on Hardware Device

b. Click on each Input or Output you want to change and enter a new name.

Server Ilocalhost j

HarcwareDevice |

Mame IHardwareDevice1

IP Address I
docule IBDBD - l

Failover howvability IMovable vl

Input Mame In Use Cukput Mame InU...
¥ |Input 0 i ¥ | Qutput 0 ™
Input 1 (] Cubput 1 (]
Input 2 (] Cukpuk 2 |»
Input 3 =l Cukput 3 =]
Input 4 | Cukput 4 (=]
Input 5 =] Cukput 5 (]

Figure 37. HardwareDevice tab in Server Configuration dialog box
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2. For camera with digital I/0O:
a. Right-click on a camera in the Camera Tree, and select Camera Setup. The Server
Configuration dialog box opens.
37 Devices
- 13 Cameral
T 2} CameraZ
@ 3) Camera3
-T2 4 Camerad
- TaE 5] Cameras
Mew CameraView | 7
=% Input Carnera Setup. .
&
& 10) Came Quick Camera Setup...
Er 5 7) Hardw Wiew on Web
i pedm Oukpy Micahle Alarms For Camera
Figure 38. Camera Tree dialog box
b. Click the Digital I/0 tab.
c. Click on each Input or Output you want to change and enter a new name.
@ Rules Server Ilocalhost j
£+ 7 Devices .
T8 1) Cameral Metwork | Wideo  Digital 1O |Analytics Engines |
-5 2) CameraZ [l |InUse || |output Name
-7 3) Camerad | I = [
o o
g 5 Cameras Y Input 2
-T2 6 Camerat
r.j D7) HardwareDevicel
-l a7
I:all Licenses
-, Matifications
@ General Settings
EH{= Storage
[E| localhost
Server Farm
2 lianb T Annackibe
Figure 39. Digital I/O tab for Axis Cameras in Server Configuration dialog box
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Activating an Output Device Using the Map Context Menu
Procedure
To activate output device using the context menu:
1. Right-click on the device. The context menu opens.
2. Click Activate. The icon turns yellow.
Map - I|:||:.alf'||:|5t - 1;:|_1r|ter'i|:|r - Huzlusé
=
— MAME AND LOGATIGN SF BTIUSTVAE
<
Figure 40. Activating an Output device on a Map
Only Output device has context menu for Activate
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Customizing Storage Settings

Symphony allows you to customize where video is stored, how much storage to use, and when video should be

deleted.

Video and logs should be stored in separate folders. Ideally, no more than 5000 files per folder. We recommend
that each camera store its video in its own folder. You can group them in a logical way so that you do not have to
manage hundreds or thousands of folders.

Procedure

To view the storage settings:

1. From the Server menu, select Configuration.

2. Using the tree view in the left pane, select Storage. The Storage Summary is displayed in the right

pane.

3. Click on one of the storage devices in the tree. Disk Usage Limits and Footage Storage
information are displayed. For details, see Table 1.

Table 1. Storage Options

Storage

Task

Disk Usage Limits

Minimum Disk Space

Specify the minimum amount of free disk space on the hard disk. Symphony
starts deleting video as soon as free disk space is below this setting.

Minimum Disk Percentage

Specify a percentage of free disk space to maintain.

Footage Storage

Limit the number of days
video is stored

Specify a global setting (Default max storage days field) or Max Storage Days
for each camera in the Footage Storage section.

In certain situations, disk space may be available to record more video, but you
may want to artificially have the video removed. This may be the case in certain
jurisdictions where you are legally required to delete video after a certain time.

Default max storage days
(global setting)

If the Limit the number of days video is stored option is enabled, specify the
default value in days when video is over written, even if extra hard disk space
exists. Alternatively, by adjusting the Max Storage Days value per camera,
individual camera settings supersede the global settings.

Keep metadata longer

Specify that metadata can be stored longer than video. This is useful in order to
maintain reporting capability.

Chapter 2
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Table 1. Storage Options (Continued)

Storage Task

Default metadata storage

days Specify how long metadata will be stored.

The default path location where video will be recorded is displayed (as defined at
Default path installation). You can adjust the path for an individual camera under the Storage
Path column in the camera table.
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Managing Server Farms

A Server Farm is a collection of computer servers used to accomplish server needs beyond the capability of one
machine. Server farms often have backup (redundant) servers, which can take over the function of primary
servers in the event of a primary server failure.

Procedure

To manage your Server Farm:
1. From the Server menu, select Configuration. The Configuration dialog appears.

2. Inthe left pane, click Server Farm. The Server Farm Summary is displayed in the right pane. The
server named displayed in bold is the Master server.

Server Configuration - InfoDew2 - Server Farm Surmmary EI
—
% Rules Overload Protection
[+#+57 Devices . S—
[3) Licenses [CMove cameras when CPU load is high |

Q Hatifications Allow redundant servers to be used {automatic Failover will nok work)
@ General Settings

L;Jél Starage CPU Usage Threshold {percent)

'lEl 10.234.5.31 Palling Frequency {seconds)
Maximurn cameras to mave

Farm ID | 74083 Server Farm configuration allows you ko add and remove servers,
and change their properties,

{= Client Connectivity
L{E] Carousels

Client Update ——————————————

& Immediste Swap Servers |

' Update during time f
[FEEID EMAE S T Server address (IP or DNS) l:l Add server From another Farm |

Remove |
(s} Address P MaC Gro.. On  License State  Status ‘ersion Device Pack
5000|C2-2-win7-64 | 10.234.5.31 |00-0C-29-29-A...) 1| [] |valid |up |4camera...|6.11.0.0 1.0.0.0

Figure 1. Server Farm
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Overload Protection

Each server monitors its own CPU load every <Polling Frequency> seconds. If it detects its CPU load exceeding
<CPU Usage Threshold>, it finds another server in the same redundancy group with the lowest load. If
redundancy is off, or the current server has the lowest load, no swapping occurs.

Once a server is found, cameras are moved starting with the highest camera ID on this server until <Maximum

cameras to move> are moved, or 25% of the total cameras on this system, whichever comes first. Cameras that
are not Movable (as per Failure Movablility setting Table 1, "Network tab - Field/button description," on page

17) are not moved.

Procedure

To set up overload protection:
1. Select the Move cameras when CPU load is high to enable all other fields.

2. (Optional) Select the Allow redundant servers to be used check box. If you select this option,
automatic failover will not work. (See “Failover” on page 76.)

3. Use the default settings or change as necessary for the following:
e CPU Usage Threshold (percent) - The CPU percentage that must be exceeded before
cameras are moved.
e Polling Frequency (seconds) - The number of seconds between checks.

e Maximum cameras to move - 25% of the server’s current camera count up to this
maximum will be moved.

e Whenever the CPU is high enough that overload protection is required, a message is sent
to the Symphony User indicating Redundancy Off, No server available, or Moved x
cameras.

Chapter 2
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Manage Servers - Client Update
If in the Symphony Client Settings for a particular client, you have selected that the server manage Device Pack
updates, then you must indicate when Device Pack updates will be installed on the Client machine.
Symphony Client Settings = @
Startup | Display | alarms | Video| Camera Wiew | Maps | Sound | Regional | User Settings | Global | Lockl Update | Advanced |
Symphony can automatically check For updates and install them,
/ Enable automatic updates \
Updates are managed by:
o Server
Server Settings
Server Farm:
|DeFauIt v|
- J
Server Configuration - InfoDew2 - Server Farm Surnmary
—
S
Eljli Li:::::s [T Move cameras when CPU Inad is high
Q Hatifications Allow redundant servers to be used {automatic Failover will not work)
- G | Sekti
@ Ereral ettings CPU Usage Threshold {percent)
300 5| Polling Frequency (seconds)
=) Client Cormectivity Maximurn cameras to mave
Carousels Manage Servers
Farm ID
Client Update
& Immeciste
" Update during time frame
End: |4:00 &M
Figure 2. Device Pack Update Installations Managed by Server
e Immediate - The Device Pack update is installed immediately.
e Update during time frame - The Device Pack update will be installed in the time frame selected.
The Client user will be prompted with one of the following messages during a Device Pack installation:
B
Symphony Update % symphany lpdats =
Update Availiable Update Availiable
Test.msi is available.
Test.mei is available. . 1t i recommended that you apply this update now,
It is recommended that you apply this update now.
Rermind me in: [10 minutes v]
[ Install [117) J [ Postpone ]
Figure 3. Device Pack Installation Update Message to Client User
e Ifanyissues are encountered during the installation process, consult Device Pack Installation
Errors.
e  For Device Pack Installation Wizard instructions, consult How to install a Device Pack.
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Farm Setup

You can create a server farm two ways:

e One atinstallation - refer to the Aimetis Symphony Installation Guide.
e By merging existing farms into a single farm - See “Creating a Farm from Multiple Existing Farms"

Creating a Farm from Multiple Existing Farms

The following steps will create a multi-server farm from 2 or more existing farms.

Procedure

To create a multi-server farm from existing farms:
1. Save configuration settings for each server:

a. If upgrading servers, save configuration settings for each server.

b. When uninstalling, select the Save Settings option.

c. Ensure all servers are installed as or upgraded to the same version of Symphony (6.2
or later).

2. Onall servers enable SQL remote access. For instructions, see,
http://support.microsoft.com/default.aspx?scid=kb;EN-US;914277

3. Choose one server to be the master, for example, Server A.

a. On the Aimetis Xnet web account, select the Servers link from the left panel.
b. Click on Server A's ID to launch the Server Settings page.
c. The ID for server A will now be considered the Farm Id. All other servers and their
ID's will become void once they are in the Farm.
d. Click the Add Server to Farm link to add the MAC addresses of all child servers to
server A.
e. Refresh the Settings page for server A to ensure all MACs have been added correctly.
4. Start Symphony Client and register the farm by [farm name] or server A's IP address or DNS name.
From the File menu, select New Symphony Server Registration.
Register Symphony Server

Symphony Server Information

Address | The location of the camera server.

There are 3 types of names allowed:

1) IP eg 45.23.23.43
2) DNS eg yourcompany.com
3) Aimetis eg [Honda Camera Server 1]

Aimetis names need to first be registered from the camera.
They are useful in cases where the client has a dynamic IP

Mame The name by which youwant to refer to this server.

Symphony Server Login Information

(e I— Your username setup on the camera server to allow access.
Password The associated password.

| Cancel

Figure 4. Register Symphony Server
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5. Open the Server Configuration Licenses page:

a. From the Server menu, select Configuration. The Server Configuration dialog box
opens.

b. Inthe left pane, select Licenses. The Licenses Summary is displayed in the right
pane.

c. Click the Refresh licenses from Aimetis.com button.

6. Inthe left pane, select Server Farm. The Server Farm information is displayed in the right pane.

e If this page is not available it may be because some standard camera licenses exist. Server
farms will only work if there are no standard licenses. All camera licenses must be
Professional and/or Enterprise.

a. Inthe Server address field, enter the IP address or DNS name of a child server to
merge into the farm. Do 1 child at a time.

b. Click the Add server from another farm button. This will add the child to the farm,
transfer all cameras and rules from the child server to the farm's database (residing
on server A), and change the database connection string on the child to point to
server A's database.

7. Restart server A and the child server that was just added.
8. Ensure that all cameras from the child have been added correctly, as well as all rules and masks.

9. Repeat steps 6a to 8 for remaining servers.

Master Server

At all times one of the servers is deemed Master. The Master takes on the additional task of controlling the
operations of a failover. If the Master happens to be the down server, another master is quickly designated to
take over the failed master's duties.

Redundant Server

A redundant server is a server currently running 0 cameras. Upon detecting a server as being down, a redundant
server is used to replace the down server's camera and device processing in its entirety. Meaning, all cameras will
be moved and run on the redundant server. Video loss will be a little as 15 seconds.
To enable redundancy:

e you must have at least 1 redundant server available at all times (one with 0 cameras).

e the redundant server must be in the same Redundancy Group as the potential down server.

¢ redundancy must be turned On for that Redundancy Group

IS Server Configuration - Iocalhost - Server, Farm Summary.

Sarver Farm configuration allows you to add and remave sarvers, and change their properties.

Swap Servers ‘

- Motifications
{0 ] General Settings

Farm ID Server address [IP or DHS) Add server From ancther Farm |

\

Drag a column header here to graup b alumn

Client Connctivity
Carousels

5000|¥M-XP-1H 10.234.1.68 | 00-0C-29-3C-4B-B4 1 Valid |Redundant 6.5.3.26827
——

Figure 5. Redundancy for Group is On
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Example 1

Server Farm configuration:

If either of the first 2 servers fail, their cameras will failover to the 3rd Redundant server.

D | address | 1P [mMac |Group  |om |License State | Skatus
5001 10.234.1.58 10.234.1.58 00-1B-77-DF-BC-3B 1 [ Walid Up Z cameras
5002 Jukel.com 125.53.24.72 AE-CD-EF-GH-11-01 1 [ Walid Up Redundant

Figure 6. Example - All three servers in the same Redundancy Group "1"

If the first server (Redundancy Group 7) fails, no failover will occur, as there is no Redundant server in
Group 7.

| address hiz [Mac | Group | on | License Skate | Status
5001 10.234.1.58 10.234.1.55 00-1B-77-DF-BC-3B 1 [l Walid 2 cameras
5002 Jukel.com 125.53.24.72 AB-CD-EF-GH-11-01 1 [ Wvalid Up Redundant

Different Redundancy Groups "1" and "7"

Chapter 2
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Example 2

Typical Symphony Server Farm:
This configuration depicts use of an external database cluster for configuration data

redundancy, and a NAS or SAN for historical footage file access after failover.

Server 1

Server 2

the remaining servers.

e
e

Database Cluster
{for configuration data)

Server 2

Server 1

Servern

Data Store
NAS or SAN

Configuration data

Multi-server Farm with configuration database existing on one of the Symphony Servers:
If server redundancy is a requirement, this is not a recommended setup, since it involves a
single point of failure, namely Server 1. If this server fails, configuration is not accessible by

Sarver n
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Redundancy Groups

Due to geographical constraints for file storage, it may be necessary for certain servers to failover only to
specific servers. A redundancy group allows you to group your servers such that failover happens only
amongst servers within the same group. Ensure that there is at least 1 redundant server within each server
group.

Buddy System

A Redundancy Group uses a buddy neighbor system where each server monitors the health of its neighbors
(or buddies). Each server broadcasts an Alive status every second to each of its buddy servers, and each
server listens for Alive messages from other neighbors. It is a connected graph of neighbors such that if more
than one server is down there will always be someone to detect them.

Each server runs a monitoring thread that receives UDP socket messages from each of its buddies.

e If the detection threshold time expires without receiving an Alive message from a particular
buddy, then that server may be down. A possible down server message is sent to the Master
server.

e If more than 1/2 of the buddies notify the Master of this down server, it is confirmed to be down.
In this case a failover camera swapping algorithm takes place to transfer all the down server's
camera processing to a redundant server if one is available.

Redundancy Configuration Settings

The following are the configurable farm redundancy settings.

Table 2. Configuration Farm Redundancy Settings

Setting Description

On server startup, it will delay by this amount before starting to

FarmHealthStartDelayMs monitor for one of its buddies being down.

UDP sockets are used to receive Alive messages from all buddies.

FarmHealthSockTimeoutMs Each will have this timeout. (You should not have to change this).

The amount of time in milliseconds a server can be down before it is
determined down and failover is performed. Some customers may
want this to be several minutes to allow a windows update reboot to
perform.

FarmHealthMissedUdpMs

Only change this if failover is not working at all and the is* log files

palimi et pRant indicate there are port conflicts.

These settings are NOT in the database by default. To add them, use the following lines. The last parameter
is the default used.

dbupdater "insert into Settings (Type,ID,Section,K,V) values ('Global',",'Main','FarmHealthStartDelayMs',  '5000')"
dbupdater "insert into Settings (Type,ID,Section,K,V) values ('Global',",'Main','FarmHealthSockTimeoutMs', '1500')"
dbupdater "insert into Settings (Type,ID,Section,K,V) values ('Global',",'Main','FarmHealthMissedUdpMs', '30000')"
dbupdater "insert into Settings (Type,ID,Section,K,V) values ('Global',",'Main','FarmHealthUdpPort’, '5045')"
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Failover

A down server is detected within 30 seconds, but can be configured for any time threshold. Windows operating
system updates or other maintenance that cause a reboot may be reason to increase this threshold to several
minutes. Failover will transfer all the camera processes from running on the down server to running on a
redundant server. It will transfer only cameras that are Movable according to the camera configuration as defined
in the Device settings. Some devices are not movable by nature (USB devices, or analog cameras plugged into a
video card on the down server for example). When a down server comes back up, and its cameras have been
failed over to another server, it will now be considered a redundant server, since it has no cameras.

Storage

Symphony supports both NAS and SAN storage:
¢ Some SANs can be configured to be accessible by multiple servers simultaneously; Symphony is
agnostic to this process
e Assuming sufficient bus capacity and disk 1/0, a SAN can be used for redundant storage in a farm
configuration
e  For further information consult your SAN documentation and support

Important: Aimetis strongly recommends a NAS in cases where failover is
required.

Each server writes its footage and files to one of the following:
1. adata folder on the server itself
2. alogical drive on a SAN
3. alogical drive on a NAS

If method 1 is applied, the footage files for a given camera will exist on the original server up until the failover
swap, from which point they will be created on the redundant server.

If method 2 or 3 is applied, the footage files for a given camera will never move. When a failover swap happens,
the new server will just point to the data of the down server's logical drive on the SAN or NAS.
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On-Camera Storage

On-camera storage for AXIS cameras provides video recording redundancy. Symphony automatically detects
if an AXIS camera supports this and has been configured for on-camera storage.

=]

Figure 7. Green bar indicates video recorded on-camera

In the Timeline, a contrasting green bar (magnified in the following figure) indicates that video was not
recorded locally in the Windows machine, but Symphony is already downloading the video from the AXIS
camera. Symphony does not analyze video downloaded from the camera. As such, it does not determine
activity type, for example, broken rule or video signal lost.

Database Configuration

All configuration settings for an entire farm are stored in a single SQL database. For this reason it is recommended
that the database reside on a reliable server in the farm, or better yet on a separate dedicated database server
set up with its own redundancy system (such as a Microsoft Windows cluster).

Without a reliable server or dedicated database server, the entire farm will no longer be able to make any
configuration changes, and stopped trackers will not be able to restart if the Symphony server that contains the
database fails.

All Symphony servers in a farm must be granted access to the centralized configuration database. To enable
remote access to the SQL server, refer to the Aimetis Symphony Installation Guide.

Symphony Client

The client application can register (connect to) any server in a farm. Upon failover, if the client's registered server
is the one that failed, one of the servers will notify the clients that a server is down and the registration will
automatically switch to an up server to take future requests.
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Configuring a Camera Tour

By default, each Pan-Tilt-Zoom (PTZ) camera has a Home Position, where it is positioned unless a user manually
controls the camera, or if the camera is automatically controlled by Symphony (for more information on auto
control, see the Rule element Actions). Using the Camera Tour function, the camera can be configured to have
multiple Home Positions. This effectively allows the camera to cover more area.

IR el
Tour Mame: éaamer;a"TEur -' Add Anather Tour
Preset I Mame Pan Tile Zoom Pause Time {sec) ‘Camera Live Yiew PTZ Controls

b1 0.00 0.00 1.00

@ 4@
b m =

Tour List Actions

| Add Current Live View PTZ Location To The List | | U_pdate Location | | Change Motion Ma_sk (Affects Trackiljg) |

| Go To Selected PTZ Location ‘ I Set Schedule For This Tour |

| Remove Selected PTZ Location ‘

Drag drop row indicator to order camera tour location oK | | apphy | I Cancel ‘

A

Figure 8. Camera Tour dialog box

Important: Analytics running on PTZ cameras in the case where the camera tour
is configured but disabled may not function correctly, as the analytic settings will
revert to defaults.
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Procedure

To configure a Camera Tour:

Chapter 2

1.

Access your PTZ camera. For example, click on the PTZ camera name in the Camera Tree.

Camera Tree - localhost

f Design

;}-}_f Devices
(T8 1) Cameral OFf
-89 %) Cameraz Off

P
..... 3 OFf
g s g Mew Camera Yiew

Camera Setup...

Date = | Tin . Lser
Quick Camera Setup...

View on Web

Disable Alarms for Camera...

Enable Alarms for Camera. ..

< Camera Tour... )
P

Stop Camera

Start Camera

Reconnect to Camera
Server

Stop Recording

Start Recording

Resume Record mode
Stop Recording Audio
Start Recording Audio

Search...

Figure 9. Right-click on the PTZ camera name

Right-click on the live view of the camera and select Camera Tour and then click Edit. from the
menu. The Camera Tour dialog box opens.

From the Tour Name drop-down list, select a tour to modify. By default, there is one Camera Tour
configuration. You can create multiple Camera Tour configurations with different tour locations and
schedules.

Using the PTZ controls, move the camera to the desired location by using the arrows, and the + and
- buttons to configure the zoom level.

To save location, in the Tour List Actions group area, click Add Current Live View PTZ Location
To The List.

By default, Symphony will move the camera between the different locations every 600 seconds. To
change this value, modify the value (in seconds) in the Pause Time field.

To modify the mask an area for the new Camera Tour location, in the Tour Options area, click
Change Motion Mask. The Server Configuration dialog box open with the Devices listed and the
mask took (eraser icon) tool active.

e This enables you to define where Symphony should track or not track objects.

e Each Camera Tour location is much like a separate camera, since it has its own field of
view. As a result, must define the Motion Mask area for each Camera Tour location. For
more information on setting a Motion Mask, see Masks.
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8. To modify perspective information for the new Camera Tour location (not all video analytic engines
require this), click Change Perspective Settings. The Camera Tour location requires its own
perspective information (to classify objects properly). For more information, see Perspective
configuration.

9. To define when this Camera Tour is active, click Set Schedule for This Tour. Since many Camera
Tours can be configured, you may decide to have a Camera Tour sequence that is different during
the day than at night. The Set Schedule for this Tour dialog allows you to configure the schedule
for this specific Camera Tour. Each Camera Tour can run on a separate schedule. Make sure that
Camera Tour schedules do not overlap in time.

10. Click Apply to save changes and OK to complete the configuration.

80
Chapter 2



Managing General Settings

Chapter 2

Managing General Settings

You can configure various system settings in the General Settings dialog box.

Server Configuration - InfoDev? - General Settings

f= = [

E_E Server Farm
{= Client Connectivity
Carousels

Enable Event Log
Ewvent archiving schedule
Ewvent archive retention (number of days to retain archived events)

[T1Enabled (turn SHIMP on or ofF)

Data polling rate {the rate in seconds that any palling SMMP sub-agent will poll For data)

Q00,0 Footage size poling rate {the rate in seconds that the Footage size will be updated)

Device Tree Synchronization

Synchronizes devices and device groups with external system, Disable if not using external system,

Synchronization Frequency (in minutes, a walue of zera disables this Feature)
Web Client

[#] randomly redirect master server logins to other available servers in the Farm (For load distribution)

Refresh rate {in seconds, frequency of updates to monitoring tab content: including timeline and alarms)

SMTP

| Test sending emall to address
| Test

SMTP server |Ioca\host:25

Sender email account |dn.nﬂt.rep|y | |dEStiHatiUl‘l_&ddl’Ess@dDmaiI‘I‘EUITI

[T Use Secure Sockets Layer (5500

|:| SMTP server requires authentication

—
{2 Rues Video Decorations o
57 Devices [l
[ Licensas [T Frame stats (FPS and Frame time deviation Decoration Text Color —— [~Decoration Text Background
) Metifications [T cwerlay camera name on video ‘ [ white j | I Black
Iél@ Storage || overlay camera ID on video [ Background Sensitive Tramsparency:  Min | —————
COL([ 10.234.5.51

m

m

User Connections \\
[7]D0 not aliow more than one concurrent conneckion per ussr

Ok Cancel

Procedure

Figure 10. General Settings dialog box

To access the General Settings dialog box:

1. From the Server menu, select Configuration. The Server Configuration dialog box opens.

2. Inthe left pane, click General Settings. The General Settings dialog box opens in the right pane.

Chapter 2
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Table 3. General Settings dialog box options
Option Task
Video Decorations
Frame stats (FPS and frame time . . . . . .
L ( Select this check box to display frame information on live video
deviation)
. Select this check box to display camera name on actual live video in
Overlay camera name on video .\ . .
addition to video title bar
. Select this check box to display camera ID on actual live video in
Overlay camera ID on video L . .
addition to video title bar
. Select from a palette of colors for text (information) that is displayed
Decoration Text Color . p. Xt (i fon) 15 display
over the video image
Text color automatically adjusts so as to contrast with background
. color of video image. For example, when the background in the video
Background Sensitive check box . . & P & .
image is light, the text becomes black, and when the background in
the video image is dark, the text becomes white.
Select from a palette of colors as background contrast to the text that
. is displayed over the video image.
Decoration Text Background . play . . &
Using the slider, you can adjust the transparency of the box to show
more or less of the video image behind the text box.
Event Log
Schedule archiving
Define how long events are saved before being over written
SNMP
Enable or disable SNMP. For more information visit SNMP section.
Indicate data polling rate in seconds.
Footage size polling rate timer (in seconds) specifies how often footage
information is updated. Default value is 60 seconds.
Device Tree Synchronization
Define synchronization frequency in minutes for devices.
The Device tree can be automatically generated and maintained from
an external source. In this scenario, Symphony needs to query the
source for changes in the camera tree structure. Define the time
interval to query the source in the Device Tree Synchronization field.
Web Client
Randomly redirect master server logins to other available servers in
the farm.
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Table 3. General Settings dialog box options (Continued)

Option Task

SMTP

You must have a SMTP server configured on the Symphony PC.
Includes username/password for the email server authentication.

SMTP server field configurable. For Google Gmail, you must also select
the Use Secure Sockets Layer (SSL) check box.

SMTP server  |smbp.grail.com: 587

Sender emall account | do-nok-reply@smtp.gmail, com:SE7

Use Secure Sockets Laver (5500
SMTP server requires authentication

User johh.smith@gmail . com

Password |********l

User Connections

Restrict user from logging in more than once per server farm.
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Specifying Licenses

The Licenses dialog box allows you to specify which license to run on which camera.

Server Configuration - 10.234.1.34 - Licenses Summary EI
License Allocation Licenses in farm:
ID | Camera 7 License Reguested License Obtained License ] Amoun ~
> 1|Cameral Best Available Enterprise Per Camera Licenses |
Professional 18 E
Enterprise |

Per Farm Licenses T

WIN-KET44FG29EK MACs Allowed
Server Farm NN O 30 90 AR B4

{= Client Connectivity
@I Carousels License For Symphony Version: 8.x

Installed Symphony Version: 85327310

Farm Enterprise features: Allowed

Purchase addttional licenses

Refresh license from Aimetis.com

Refresh license from file

Show Raw License

QK Cancel

Figure 11. Licenses dialog box

Procedure

To view the License dialog box:
1. From the Server menu, select Configuration. The Server Configuration dialog box opens.

2. Inthe left pane, select Licenses. The Licenses Summary is displayed in the right pane. The
Licenses Summary indicates counts of each license type per server.
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Modifying License Settings for a Specific Server
Procedure
To modify license settings for a specific server:
1. From the Server menu, select Configuration. The Server Configuration dialog box opens.
2. Inthe left pane, select Licenses. The Licenses Summary is displayed in the right pane.
3. Click on the server in the Licenses tree in the left pane. The Licenses Allocation for that server
appears. It displays how many licenses are available and what type of license is applied per camera.
4. To change License types between cameras, select a licence type from the License Requested
drop-down field adjacent to each camera. If the Licensed Requested field does not equal the
License Obtained field, this indicates that this license was not available.
5. Click OK to save changes.
Table 4. Additional License Tasks
Button Action
Purchase additional licenses L|nk.s.you tg the Aimetis Xnet where you can log into your account and obtain
additional licenses.
. If a newer license is available for your server, clicking this button will force
Refresh license from . . .
. . Symphony to download the latest license file. (You must have internet
Aimetis.com . . .
connectivity for this option.)
If you have a Symphony server without internet access, or are otherwise
Refresh license from file unable to automatically download a new license, this option allows you to
download the license and then manually apply it to the server.
Show Raw License Displays the raw license in XML.
Note: In a Server Farm, the entire farm shares one license file. All cameras and
licenses will be summarized as if it were one physical server.
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Using the Manual Configuration Editor

Symphony settings can be changed by modifying the configuration settings directly, which are stored in the SQL
database. The configuration can be accessed directly through Symphony Client. This may be required for less
common features that do not have a graphical user interface and must be configured through the configuration

files directly.
Caution: Modifying configuration incorrectly can cause serious problems that
may require you to reinstall Symphony. Aimetis cannot guarantee that problems
resulting from incorrectly modifying the configuration files can be solved. Do this
at your own risk.

Procedure

To manually edit the configuration files:

Chapter 2

1.
2.

From the Server menu, select Manual Configuration Editor.

Modify the portion of the configuration by navigating to the value under the Value column

Add a new setting. Click the Add a new setting... field. Enter values under each column (Figure 12
on page 86).

Click OK to save changes.

Restart the Symphony services in order for the changes to take effect.

Server Configuration - 10.234.1.34 EI@
Note, certain setting changes require services to be manually restarted.
—Setting
Type #
Type | Section jin} S Key Value Action

( Add & new setting.. )

=l Type: Camera

[+ ID: 1
[+ ID: 2

= Type: Global

Copy Setting | | Delete Setting | | Revert Setting | | Refresh all | | OK | | Close |

Figure 12. Manual Configuration Editor with the Add a new setting button featured
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Setting Up Notifications

Use Notifications to automatically email information to users when an event occurs on the Symphony server, for
example, when some configuration has changed.

¢ The Notifications are NOT used for Alarms. To be notified via email whenever an alarm occurs, you
must first set up Rule Actions in the Email tab of the Rules Wizard. This allows different users to
be notified only for specific Rules triggers (for example, user A wishes to be notified in a vehicle
parks, user B wishes to be notified if people are loitering).

e Each email includes the username, IP, date/time, and event-specific content.

Server Configuration - InfoDew? - Motifications EI@
@ Rules ) ; .
_tllf Devices Event Enter a list of semi-colon separated email addresses
o[ Licenses Alarm marked [
P8 riotifications
@ General Settings Alarms dizabled |
{= Storage
L[ 10.234.5.31 Audio played |
| Server Farm ) )
{= Client Connectivity RUTIR ) R |
-4 Carousels Client connection [
Devices changed |
Wideo or Search deleted |
Rulez changed |
Search performed |
Services changed |
Settings changed |
Subscriptions changed |
Unauthotized access |
Uszers changed |
Widen exported |
Figure 13. Notifications

To view the Notifications dialog box:
1. From the Server menu, select Configuration. The Server Configuration dialog box opens.

2. Inthe left pane, click Notifications. The Notifications list is displayed in the right pane.
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Adding Subscribers to Individual Events

Procedure

To add subscribers to individual events:

1. From the Server menu, select Configuration. The Server Configuration dialog box opens.

2. Inthe left pane, click Notifications. The Notifications list is displayed in the right pane.

3. Nextto each event listed under the Event column, enter an email address in the corresponding text

box. To add multiple recipients of an event, separate the email addresses with a semicolon. For a
description of notifications, see Table 5.

4. Click OK to save changes.

Table 5. Event Descriptions

Event

Description

Alarm marked

An alarm was marked as false or real or comments were added via the alarm log
panel.

Audio played

A user played a sound file or spoke over the speaker using the Alarm console.

Audit log retrieved

The audit logs detailing everything that occurs on the Symphony server were
retrieved

Client connection

A user connected from Symphony Client.

Devices changed

A user has added, deleted, or modified a Device.

Exported video

A user has exported video from the system.

Video or Search
deleted

A user has deleted one of the following:
¢ video from the system

* a recurring search definition: no footage will have actually been deleted as a result,
the recurring search simply will not continue to recur

* a search result: the metadata about the result will be removed as well as the .aira
and .mpg files saved explicitly for that result (the original footage is untouched)

Rules changed

A user added, deleted, or changed a Rule.

PTZ Control

A user has taken control over a PTZ camera.

Search performed

A user performed a video search.

Server updated

The Symphony server code was updated to a new version from Aimetis.

Services changed

A user changed which Services are running.

Settings changed

A user changed camera, video, or other miscellaneous setting.

Subscriptions
changed

A user changed settings on this form.

Unauthorized access

A user tried to access something he or she was not allowed to access.

Users changed

Users were added, deleted, or changed

Chapter 2
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Integrating 3rd Party Systems with Symphony

Symphony can interface with 3rd party systems (such as alarm panels or access control products) using any of
following ways:

e Using I/0 Device

e TCPtabin Actions

e SDK

e Packaged Integrations

Using I/O Device

Symphony can communicate with external systems by interfacing with dry contact (or Input/Output) devices.
This is the simplest form of access control support.

e To receive alarms via I/O device, configure a Rule where the input is the dry contact of a network
camera or external |0 device.

e Symphony can also close relay's on I/O devices by configuring the Actions tab in the Rule Wizard.

TCP tab in Actions

Another way of sending alarms to external systems is by using the TCP tab in the Actions menu. On alarm,
the Rule Action will be to send a plain text message to a designated IP/Port on the network.

SDK

Symphony can communicate more richly with 3rd party systems via the Aimetis SDK. The SDK includes
numerous sample applications with source code, which demonstrate communicating over a TCP/IP network.

Packaged Integrations

Symphony has pre-packaged integrations with Access Control Manufacturers. For more information, refer to
the Technical Paper on Access Control Support.
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Configuring and Managing a Video Wall

With Aimetis Symphony, you can create video walls by using numerous PCs and controlling them remotely
through the network.

The video wall is not a physical wall but a software representation of a collection of real monitors displaying
video.
e The collection of monitors could be on a single wall in a room or in different physical locations.
e  Multiple video walls can be associated with a farm, each with different sets and layouts of
monitors.
Any Symphony Client can become a Video Wall Client.
¢ When a Symphony Client is designated as a Video Wall Client, all monitors associated with that
client can be included in a video wall.
e Any client on the network can control the monitors remotely.

For video wall functionality, Professional or Enterprise licenses must be used. No Standard licenses can be used.

Monitor #1 M onitor #2 M onitor #3 M onitor #4
DVI DVI
Video Wall Client Video Wall Client

Command to
switch camera sent
through network -

Video Wall
Window

Aimetis Symphony Client

Figure 14. Video Wall
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Procedure

To configure and manage Video Walls from Symphony Client:
Task 1: Register the PCs (clients) whose monitors will be used in the Video Wall

1. Login to every computer (client) that is physically connected to the monitors which will be used in
the Video Wall. Using the following diagram as an example, you would login to computer (client) B
or C or both.

2. Launch the Symphony Client software.

Monitor #1 Monitor #2 Monitor #3 Monitor #4

Register this
computer to
be usedina
Video Wall

Register this
computer to
be usedina
Video Wall

Command to
switch camera sent
through network

Video Wall

Window
Layout and contro

Design the Video Wall on
this PC and control B & C.

Figure 15. Video Wall setup diagram
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3. From the Server menu, select Video Wall.

Symphony Client \6.5.3.2?%
File  View  Bookmarks \ Server | JSearch  Reports  Help
\l-—-"

| Load Multi View - [P T¢ | Alarm Console...

WIN-KET44FG29EK-MV Console+ Disable Alarms for Server...
B Timeline | b Mavigation Enable Alarms for Server...
@) GetInfo..

Delete Old Footage...

View Logins

[ Configuration...  Ctrl+Shift+C
g User Configuration...
Device Tree Configuration...

Security Profiles...

Manual Configuration Editor...

Add Access Devices

Backup...

Restore...

Services 4
Video Wall J_I

Figure 16. Server menu > Video Wall

4. The Video Wall dialog box opens. Click the Video Wall Client Configuration tab.

5. Click Register current Symphony Client. This allows you to remotely control that registered client
from a video wall window you will create in Task 2. (You will be able to remotely control video,
switch cameras, create/change/close a Multi View and more of that registered client.) Aimetis
provides an SDK for this feature. For more details, see
https://lwww.aimetis.com/Xnet/Downloads/Files.aspx?P=development%2fSDK.

(| video Wall : 10.234.1.34 =n| Wl <
e B
Video Wal! Video Wall Client Configuration |}

Current video wall dients registered in farm

MAC P Part Video Wall Client Name Enable Security ( Register current Symphony Client w

00-0C-29-F9-DB-AS 10.234.1.34 50005 WIN-K6T44FG29EK

Unregister current Symphony Client

Enable Security for current Symphony Client;

If you make changes to 'Enable Security’, you must restart Symphony Client.

Figure 17. Video Wall dialog box
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Task 2: Design the Video Wall
1. Login to a computer (client) that you want to use to design the video wall layout and control the
computers you registered in Task 1. Using the following diagram as an example, you would login to
computer (client) A.
Monitor #1 Monitor #2 Monitor #3 M onitor #4
. ov S ovi
Register this Register this
computer to computer to
be usedina be usedina
Video Wall Video Wall
Command to
switch camera sent
through network
Video Wall
Window
Layout and contro
Design the Video Wall on
this PC and control B & C.
Figure 18. Use computer A to design the video wall
2. Launch Symphony Client.
3. From the Server menu, select Video Wall. The Video Wall dialog box opens.
4. From the File menu, select Design Video Wall. The Video Wall Designer opens (Figure 19).
5. Click New to create a new layout. By default, the layout is named VideoWalll. You can rename the
layout by clicking on the name to edit/type a new name.
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'},_i Video Wall Designer
File Edit L.,] | ")
Video Walls E 1 1 1 1 2 1 3 1 4 1 5 1
VideoWall 1
Jr - ¥ |5l Deta
No Video Wall file has been opened yet.
il Please click button ' Open "in panel " Video Walls .
! :
Mew m Open | | Delete | il
:TooIBox 7
Standard Controls * 3
L‘; Pointer
_:J'- Video Wall Monitor .
?
Monitor Properties i
Monitor = 5
Label
4 n
Detail { Height:500 } .
Figure 19. Video Wall Designer
6. Select the name of the video wall and click Open. A message in the layout field appears, indicating
that you must now select the monitors be used in the video wall you plan to design. Using the
example diagram (Figure 18 on page 93), you would select B-Monitor 1 or 2 or C.-Monitor 3 or 4.
7. Inthe left pane, under Tool Box, select the Video Wall Monitor icon link and drag it to the grid. If
more than one monitor is connected drag it to the grid as well.
8. A black box including the name of the monitor is displayed in the gird. Click the box to activate it.
The name of the monitor is displayed in Monitor Properties in the left pane in the Monitor and
Label fields (Figure 20 on page 95).
9. (Optional) You can label the monitor with a short, easily identifiable name, for example Monitor B.
Edit the Label field to enter the name. Click Apply.
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i Video Wall Designer
File Edit [g] ] &>

Video Walls

deoWalll
Video\Wall2

| MNew

|| Cpen || Delete |

Tool Box

Standard Controls

Monitor Properties }

Monitor  [WIN-K6T44FG29EK-M1

Label lonitor B

Apply

4

] WIN-K6T44F G29EK-M1

-

m

=/ B

1

toolBoxMonitorl { Loc:0,110 Size:400,320 }

3

Zoom Facter: 100%

10. You can resize the monitors represented in the grid. Click on the monitor and drag the sizing boxes
as necessary. To move the monitor in the grid, click on the center of the black box and drag the

entire box.

Figure 20. Changing the Label of the monitor

%4 Video Wall Designer
Eile Edit [& |

Video Walls

VideoWall1

| Mew || Open || Delete |

Tool Box

Standard Controls *

L‘} Pointer

B¢ video Wall Monitor

Ao o

ra

WIN-K6T44FG29EK-M1

Chapter 2

Figure 21. Resizing Monitor
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11. When are you satisfied with the layout, you must save it. From the File menu, select Save and then
Exit.

Task 3: Adjust the Video Wall layout and control

1. Launch Symphony Client on the computer where you designed the Video Wall layout. (For example,
in Figure 18 on page 93, that would be computer A.)

2. From the Server menu, select Video Wall. The Video Wall dialog box opens.
3. Click the Video Wall tab.

4. From the Current Video Wall drop-down field, select a layout. (This is the layout you saved in Task
2.)

monitors. (Using the example diagram in Figure 18 on page 93, you would be in

| Important: At this point, your are now in control of the display on other
control of the layout on Client B or C.)

5.  You have several options to control layout on the registered monitors.

e  “Camera Tree” on page 97

e “Add Camera View” on page 98

e  “Change Camera View or Close Camera View” on page 99

e  “Camera View Context Menu” on page 100

e  “Camera View Context Menu” on page 101

e  “Save Current Video Wall Layout/Load Current Video Layout” on page 102
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Camera Tree
To change cameras, from the main menu of the Video Wall dialog box, click Camera Tree. The Camera Tree
panel is displayed. Drag a camera from the Camera Tree into the layout,
[ video wall : ga-2 =n Nl <
e |[Comers Tee] B
Wideo Wall | Yideo Wall Clisnt Configuration |
Current Video Yifall:  VideoWwalll w | Refresh | Zoorn In Zoorn Out 100% MNumber of Carmera Yiews:
* | Camera Tree
=HFT Devices
LT 2 AXIS 241011
T ) AXIS 24101 _4
T52-M1 - 4) Auis PI343
@ 1) Axisz31D
@ 5) AxisZ32D
; 6) Cameral
| f 73 Outside
... |
T
[ & L4
D ' ‘ EER L
>
4 m
Figure 22. Drag cameras to video wall
Chapter 2
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Add Camera View
Allows you to change the layout of the registered clients to Camera View.
1. Click title bar of the monitor to activate the button.
2. Click the Add Camera View button.
3. From the Number of Camera Views drop-down list, select the number of camera views.
Fibe | Camera Tree
Wi Wl | ickeo Wl Clent Conégr ason
Cumtent Video Wallk  “yvidesnsl » | Refresh | Zoom ln Zeoen Out 100% HNumber of Camera Views. 4 Add Camnera Vipw
T eRGI
Figure 23. Activate the Add Camera View button
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Change Camera View or Close Camera View

You can change or close the views on the remote clients from here.

1.

Chapter 2

Click on the Camera View bar. The Change Camera View and Close Camera View buttons become

active.

If you click Change Camera View, select the number of camera views from the Number of Camera

Views drop-down list.

Fie | Camnera Tree

[k el | it viad Chert Contigr sban

| Corrent Video Walk | Myvdecial

WNETAFC I M)

Figure 24. Activate the Change Multi View and Close Camera View buttons

= | Fefresh | Zoom bn Zoom Out 100%

Humber of Cameea Views: 4

Change Camens View Close Camen iew

Tevices
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Camera View Context Menu

If you have a Camera View display, right-click on the multi view bar (not the monitor title bar). The context
menu appears. You can show/hide the Tool Strip, Timeline, Navigation Bar, or display full screen on the
remote clients.

m Symphony Client v6.5.3.27672 o || =) &2
File  View Bookmarks Server  Search  Reports  Help F:y j| | =] [@ | || B4l [Be B8 [q% 25
(5] | Load Multi \u’ier“Z! Tool Str\p| B= Timeline kel Navigation | (3 (B3 [&] Carousel - Send Picture To~ Camera Tree -
| WIN-KET44FG29EK-MV Consale-P1: <no camera> WIN-KST4FG29EK-MV ConsoleP2: <no camera> . # Design
B Timeline |l Mavigation || || Date B Timeline Lel Navigation || [ Date I = '? Devices
B o LT 1) AXIS Q74011 1 Off

e || Camera Tree

Remote client

[ VidedWall :

Video Wall | VldNVaII Client Conﬁglkuonl
Current Video WallN MyVideowall \_V | Refresh | Zoom In Zoom Qut 100% MNumber of Camera Views: 4

WIN-KET449FG29EK-MV Console-P3: <no camera> \

B Timeline Lo Navigation | ki WIN-KET44FG 29EKN

Right-click on
Multi View
layout title bar
(blue bar) to
show context
menu. Controls
layout on
remote clients.

.

Full Screen

Show Tool Strip

Show Timeline

Show Mavigation Bar

Figure 25. Remotely change the layout of all monitors
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Camera View Context Menu

Right-click on a panel (not the monitor title bar). The context menu appears. You can enable live video,
show/hide the Tool Strip, Timeline, Navigation Bar, or change the Camera View Settings on the remote
client.

Symphony Client v6.5.3.27672
File  View Bookmarks  Server  5Search  Reports  Help _é _d"‘l ﬁ [

$FEIE[FEE 7 ], E 5 R 5

[ | Load Multi Viewv| = Tool Strip| = Timeline |d Navigation | (5 [B3 K] Carousel » Send Picture To ~ Camera Tree -

WIN-KET44FG29EK-MV ConsoleP1: <no camera> WIN-KET44FG29EK-MV ConsoleP2: <no camera>

Em. ;}ﬂ Devices

= TImE|lnE|H MNavigation | Decoration || [~ Date : : B Timeline |l Mavigation | Decoration | |- Date

-

[ Video Wall

[Manmens B4

Video Wall | Video W

File || Camera Tree

This is the

Current Video Wall: - MyVideoWal Fefresh | ZoomIn Zoom Out 100%

MNu

remote client.

Video Wall Window

WIN-KET44FG29EK-M1

I Right-click

| on individual
_— panel to

Enable Live Video Show

Show Tool Strip context
Show Timeline menu.

Show Navigation Bar

Settings

Close

Figure 26. Change the layout in one panel
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Save Current Video Wall Layout/Load Current Video Layout

Video Wall ; InfoDev2

Save Current Wideo Wiall Layout
Load CurrentVideo Wall Layout  »
Delete Video Wall Layout »

e This layout is saved on the remote computer (client) and NOT on the controlling computer. Using
the example diagram (Figure 18 on page 93), the layout would be saved on computer B or C (if Cis
online) but not on A. Each connected (registered) video wall client saves (or loads) its client layout
on its own machine.

e The layout name, however, is also saved in the database.

Refresh

If you click the Refresh button, all screens are updated immediately; otherwise, the Video Wall Window
updates each camera view screenshot in round-robin. It takes 30 seconds to update all camera views.

Zoom In/Zoom Out

Allows you to zoom layout. It does not zoom the images on the remote (registered clients).

Full Screen Mode

In video wall manager, you can double-click on a panel to display the image in full screen mode.
Double-clicking again restores the view to the previous state.

@ ‘Wideo wall Clenk Configuration

Cusrert Vidoo Wal:  Videchsll = | Refresh | Zote In ZooeOut L00% b of Carmeea Views

Double-click on panel in Video Manager to
display full screen in Video Wall

Figure 27. Full screen mode
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Viewing Detailed Logs

The View Detailed Logs feature provides a view of all logs recorded on Symphony server and Symphony Client.

Procedure

To view detailed logs:

1. From the Help menu, select View Detailed Logs. The View Detailed Logs dialog box opens for the

current date.

2. By default, the client logs are shown. To access the server logs, click a server in the list. The server

name i

3. Forad

s displayed in square brackets.

escription of menu options, see Table 6. You can right-click on the menu bar to Customize

the menu and tool bar.

Important: It could take several minutes to get all log files from with a slow

* connection.

Table 6. View Detailed Log dialog box menu options

Menu option

Description/Action

Date

Shows the logs for the current date. Click the drop-down arrow to activate the
calendar interface and select another date.

Copy to Clipboard

Copies Entire text to clipboard.

Download

Zips all log files and places them on your desktop. You can then send them to
Aimetis for troubleshooting.

Find Next

Enter text to query the log file.

Chapter 2
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Viewing Logins

The View Logins feature can be used to see who is accessing a Symphony server.

Procedure

To view logins:

1.

2
3.
4

From the Server menu, select View Logins. The User Logins dialog box opens.
From the Date drop-down list, select a day to view.
(Optional) To copy data to the clipboard, click Copy to Clipboard.

(Optional) To group by a column header, drag the column header to the top, above the other
columns.

(Optional) To print, export, or send the log via email, click Print and Export. The Preview dialog box
opens. From the File menu, select any of the options.

Exporting Data from the User Logins Dialog Box

Procedure

To export data from the User Logins dialog box:

1.

2
3.
4

Chapter 2

From the Server menu, select View Logins. The User Logins dialog box opens.
From the Date drop-down list, select a day to view.

Click Print and Export. The Preview dialog box opens.

From the File menu, select Export Document, and then one of the many formats (PDF, HTML MHT
RTF, XLS, XLSX, CSV, Text, Image). Depending on your selection, additional formatting dialog boxes
open, allowing you to refine your exported file.
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Displaying a List of Users Viewing a Camera

As an administrator, you can determine which users are using a camera.

Procedure

To display a list of users using a camera:

1. Right-click on a camerain the Camera Tree.

2. From the context menu, select Users Viewing Camera. The Users View Camera dialog box opens
listing the user name of the user viewing the camera selected.

3. (Optional) Click Refresh to display an updated list.

Chapter 2

Camera Tree

# Design

(HEH] Camera Views
¢ L.IEH| Main Hall - 4 Camera View

Mew Carnera Wiew

Carmera Setup..,

Quick Camera Setup...

Wiewr on Wieb
I——r—"——— K
Alarm Log - 0 Mew, 0 Disable Alarms for Camera..,
27 Advanced Mad Enable Alarms for Camera...
Date Time Stop Camera

Start Carnera

Reconnect to Carmera

Stop Recording
Start Recording
Resurne Record mode
Stop Recording Audio
Start Recording Audio

Server Lisk
Search..,

Server

CUsers Wiewing Carnera )

Figure 28. Camera Tree context menu

Users Wiewing Carnera EI@

1) Cameral

Last Updated 10/03/2012 2:06:51 PM

User name
Securityl

Figure 29. Users Viewing Camera
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Viewing Detailed Events

Any event or action caused by a user or the system user is logged in the database. This information may be
exported as PDF, HTML, MHT, RTF, Excel, CSV, Text or image file.

Information is sorted by Time, Name, EventID, GrouplD, Key and Value.

Procedure

To view detailed events:
1. From the Help menu, select View Detailed Events. The View Detailed Events dialog box opens
with events listed based on a Start and End date.
2. (Optional) You can select a specific date/time frame by selecting a Start and End date/time and
clicking Reload.

3. (Optional) You can filter information by right-clicking a column and selecting Filter Editor. (The
right-click menu offers various sorting options.)

Wiew Detailed Events
Start 01/10/2013 » 11:00AM 2 End 01/10/2003 = 11:53PM 3 Reload | Bxport..

Time Marne Event ID Group ID Key
I=E] 1027 -chd0-41 Oc4 sessionld

ch cf
1027 &§72453b5-cbd0-4f33-9335-6c51509e70c4 username Securityl

1027 872453b8-cbd0-4f33-9335-6c5180%7004 clientAddrass 10,234.5.31

D01/10f2013 02:06:29 P SessionCreated

|01110,|’2013 0Z2:06:29 PM SessionCreated

Figure 30. View Detailed Events
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Health Monitoring

If the Health Monitoring option has been purchased, Symphony Server sends every 15 minutes for each camera
a health packet which contains health information about the server.

Aimetis offers a managed service that enables users to login to the Aimetis Xnet (http://aimetis.com/xnet/)
and see the status on all Symphony Services. Health Packets are sent as UDP packets.

Each Health Packet contains the following information:

Server name

Server ID

Camera ID

Source IP address

Version of Aimetis software running on the server
Amount of CPU the Al Tracker has used

How long the Al Tracker has been running
Number of alarms

Amount of free disk space

The health packet interval can be re-configured in the Manual Configuration Editor.

Caution: Modifying configuration incorrectly can cause serious problems that
may require you to reinstall Symphony. Aimetis cannot guarantee that problems
resulting from incorrectly modifying the configuration files can be solved. Do this
at your own risk.

Procedure

To reconfigure the health packet interval:

1.
2.
3.

Chapter 2

From the Server menu, select Manual Configuration Editor.
Select the Section = Main and Key = Statuslinterval row.
In the Value field, enter the number of seconds between packets. The default value is 900.

e To apply change to a single server only, select the row where Type = Server, Id = the
server's logical ID.

e Toapply to all servers in the farm, select the row where Type = Global and Id = <empty
string>

Click OK to save changes.

Restart the Symphony services in order for the changes to take effect.
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Enabling SNMP

Symphony SNMP support is built upon Microsoft's Extendible SNMP Agent. During Symphony installation, the
Symphony SNMP Extension-Agent is registered with Microsoft's SNMP Agent by modifying the Windows registry.

Important: The Symphony Get Info feature provides more information than
“Walking” through mib files using a SNMP query tool. See “Receiving Full
Diagnostic Information” on page 116.

Server Configuration - InfoDev - General Settings EI@
—
{2 Rules ¥ideo Decorations
“F7 Devices
Lj'?l—;g U [] Frame stats (FPS and Frame time deviation) Decoration Text Color — | [ Decoration Text Background
- 4] Licenses
{2 Natifications [ owerlay camera name on video | - j | I Elack j
i [ overlay camera ID on video [T Background Sensitive Transparency:  Min | T Max
L[ 10,234,466 Event Log
-l Server Farm Enable Event Log

{7 Client Connectivity

|| Carousels Event archiving schedule
Event archive retention {number of days to retain archived events)

[T Enabled (turn SMMP an or ofF)

15 Data polling rate (the rate in seconds that any polling SMMP sub-agent will poll For data)

m Footage size polling rate (the rate in seconds that the footage size will be updated)

Device Tree Synchronization

Synchronizes devices and device groups with external system, Disable if not using external system,
Synchronization frequency (in minutes, a value of zero disables this Feature)

Web Client

Randomly redirect master server logins to other available servers in the Farm (For load distribution)

Refresh rate {in seconds, frequency of updates to monitoring tab content including timeline and alarms)

SMTP server |,bfdy;g_;f |

destination_address@domain,com | Tesk

Sender email account |do-ngf-fqojy@bca#]osf |

"Test zending email to address

|:| SMTP server requires authentication

Figure 31. General Settings dialog box featuring SNMP
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Procedure

To enable SNMP in Symphony:

Ensure that Microsoft's SNMP Windows Component is installed and set to start automatically with Windows.

Task 1: Enable SNMP in Symphony

1. From the Server menu, select Configuration.

2. Inthe left pane, click General Settings. The General Settings dialog box opens

(Figure 31).
3. Inthe SNMP group area, select the Enabled check box and click OK.

4. Restart Symphony services: From the Server menu, select Services, and then Start Symphony

Services.

Task 2: Configure SNMP Service Security

Microsoft’s SNMP Agent supports SNMP v2c; therefore, the SNMP Agent must be configured with the accepted

community names and hosts.

1. Ensure that SNMP service is installed on your machine: Control Panel>Programs and
Features>Windows Features>Simple Network Management Protocol(SNMP) check box.

[ ;E_-_SS_

@uvlm b Control Panel v Al Control Panelterms b Programs and Features

Control Panel Home .
Uninstall or change a program

View installed updates

To uninstall a pregram, select it from the list and then click Uninstall, Change, or Repair.

f‘g' Turn Windows features on or

off "—'———____p E’L Wifindowrs Features

To turn a feature on, select its check box. To turn a feature off, clear its
check box A filled box means that anly part of the feature is turned on,

| | Microsoft MET Frarmework 3.5.1
) Microsaft Message Queue (MSRAQ) Server
Print and Document Services

Rernote Differential Compression
) RIP Listener

1 WML SNMP
Sirnple TCPIP services (e, echo, daytirme etc)
| Tahlet PC Cormponents
J Telnet Client

Telnet Server

TFTP Client

E=8 EoR ==

Turn Windows features on or off @

m

QK | | Cancel

PR e

' Currently installed programs Total size: 1.00 GB
}'.‘3 b 24 programs installed

v | +y | | Search Programs and Feotures

i=

Installed On

2f12/2013
2/12/2013
2f12/2013
2112013
141672013
1/16/2013
10/20/2012
10/26,2012
10/26,/2012
104372012
10/3/2012
82272012
42,2012
8122012
872/2012
143072012

TAINSINAD

Je)

®

Size *

m

Figure 32. Windows Feature: SNMP
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2. Ensure that you are logged on as local administrator; otherwise, depending on your Windows
operating system, the Security tab in the SNMP Service Properties dialog box will not be
accessible or visible.

3. Viathe Windows Services management console, open the properties of the SNMP Service.

O Services

=

File Action ‘iew Help
|IEoz HE > enw

L Services (Local)

5 Senvices (Local)
SNMP Service

Stop the service
Restart the service

Description:

Enables Simple Network
Management Protocel (SNMP)
requests to be processed by this
computer, If this service is stopped,
the computer will be unable to
process SNMP requests, If this service
is disabled, any services that explicitly
depend on it will fail to start.

MNarme

o Server

" Shell Hardvvare Detection
o Smart Card

o5 3mart Card Remowval Policy

o SNMP Trap

oy Software Protection
* SPP Notification S¢
" SQL Server (AIMET]
S0 S0L Server Active [
p S0L Server Browserf
7 SQL Server VS Wi
oy 35DP Discovery

o Storage Service

o Supetfetch

i System Event Motif
i Tablet PC Input Sel
S Task Scheduler

i TCP/IP NetBIOS Helper
o Telephany

iy Themes

Start
Stop
Pause
Resume

Restart

All Tasks
Refresh
Properties

Help

Description

Supports fil...

Prowvides no..,

Manages ac..,

Allowes the

s tra..
the ..

5 S0,

5 stou.
inte...

1550,

s thu,

e PP

|5 gra.
fs a..

rs sy,
| Tab..,
Enables a us..

Provides su..

Provides Tel...

Provides us...

Status

Started
Started

Started

Started

Started

Started
Started

Started
Started

Started

Startup Type
Automatic
Automatic
Manual
Manual

Manual
Automatic (D...
Manual
Automatic
Disabled
Disabled
Automatic
Manual
Manual
Automatic
Automatic
Manual
Automatic
Automatic
Manual
Automatic

Log On &s

Local Syste..
Local Syste..,
Local Service
Local Syste..,

Local Service
Metwork 5.,
Local Service
Local Syste..
Metwork 5.,
Metwork 5.,
Local Syste..
Local Service
Local Syste..
Local Syste..,
Local Syste..,
Local Syste..
Local Syste..,
Local Service
Metwork 5.,
Local Syste..,

\ Extended /(Standard /

Opens the properties dialog box for the current selection,

Figure 33. Windows Services dialog box with SNMP Service

4. Click the Security tab.
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SMMP Service Properties (Local Computer) @

| General I Log On I Fecovery I Agent I Traps | Security Dependencies|

Send authentication trap

Accepted community names

Community Rightz

Add... Edi... Remove

() Accept SNMP packets fram any host
@ Accept SNMP packets from these hosts

]

[ #gd. | [ Edt. | [ Remove |

Leam mare about SHEP

[ QK ][ Cancel ] Apply

Figure 34. SNMP Service Properties dialog box

5. Create the desired communities (for example “public=" community with “READ ONLY” rights)
6. (Optional) Restrict which hosts may issue SNMP requests.
7. Click OK.

Task 3: Test SNMP

1. Start the Symphony services: From the Server menu, select Services, and then Start Symphony
Services.
At this time, SNMP data is provided by the Al InfoService and Al Watchdog services.

e The Al Watchdog service is responsible for providing the service status SNMP values, and
Al InfoService all other values.

e The Al SNMP Registry serves as a registration of all the sub-agents (and is used by our
SNMP Extension Agent).

e The Symphony management values are rooted at object-identifier 1.3.6.1.4.1.34101.1.

2. Use an SNMP software package to query the SNMP Agent. For example, you can use a GUI tool such
as the iReasoning MIB Browser: http://ireasoning.com/mibbrowser.shtml.

3. Start the MIB Browser and open the Symphony mib files. The Symphony mib files are typically
located in the program files: C:\Program Files\Aimetis\Symphony\mib files.

¢ If you are using the iReasoning MIB Browser, for example, you must load the Symphony
mib files into the browser: File>Load MIBs. In the file manager that opens, navigate to
and select the Symphony mib files (aimetis.mib and symphony.mib).
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4. Walk all the management values currently available within the Symphony sub-tree.

Address: | 127.0.0.1 - Advanced... |O]D: .1.3.6.1.4.1.34101.1 ~ | Operations: | Walk - 0
SNMP MIBs Result Table | Trap Receiver x
4% MIB Tree Name/OID Value Type
. RFC1213-MIB.iso.org.dod.internet.mgmt.mib-2 |seryverld.0 5000 Gauge
. HOST-RESOURCES-MIB.iso.org.dod.internet.mi |'serverMame.0 WINKET44FG 296K OctetString
‘A]IdEI'IS-I'dIB.iso.org.dod.inhemet.pﬁvahe.enhe serverVersion. 5.5.3.23499 OctetString
webserviceVersion.0 6.35 Octetsiring
) serverInfo cameraMessageVersion.0 0.1 OctetString
) dientBandwidth streamingVersion.0 13 OctetString
. cameralnfo connectedClientNumber.0 1 Gauge
. storageInfo connectedClientIndex. 1 1 Gauge
, serviceInfo connectedClientlpAddress. 1 10.234.10.61 IpAddress
, loginMonitor connectedClientUsername. 1 user OctetString
connectedClientDuration. 1 32 seconds (3200) MimeTicks
connectedClientDataReceived. 1 0 Gauge
connectedClientCurrentBandwidth.1 |0 Gauge
cameraMumber. 0 0 Gauge
storagePoolNumber.0 0 Gauge
infoServiceStatus.0 Running OctetString
netSendHistStatus.0 Running OctetString
schedulerStatus.0 Running DctetString
trackerMumber. 0 0 Gauge

Figure 35. MIB Browser displays Symphony mib files after a “Walk” operation

5. Forindividual object-identifier descriptions, consult Table 7.

Table 7. Mib file details

Category Details Description Trap Yes/No
server Info Server ID

Server Computer Name
versioninfo Server version Assembly version of the Symphony

server

webserviceVersion

Version for Symphony web-service
protocol

cameraMessageVersion

Version for Symphony camera
message protocol

streamingVersion

Version for Symphony streaming
protocol

clientBandwidth

connectedClientNumber

Number of connected clients to this
Symphony server

connectedClientindex

Unique value for each connected
client

connectedClientlpAddress

IP address the client is connected
from

connectedClientUsername

Username that the client is
connected with

connectedClientDuration

Duration that the client has been
connect to this server

Chapter 2
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Table 7. Mib file details (Continued)

Category Details Description Trap Yes/No
. . Dat ived, in Kbytes, by th
connectedClientDataReceived ? @ re'celvt.a S .es e
client via this connection
Current bandwidth, in Kbytes per
connectedClientCurrentBandWidth second, between client and this
server
Number of cameras managed by this
cameralnfo cameraNumber
server
cameralD Unique identifier for the camera
cameraName Name of camera
footagePath Path to camera’s footage

footageSize

Size of camera’s footage in bytes

storagelnfo

storagePoolNumber

Number of storage pools managed
by this server

storagePath

Path to the storage pool

storageCapacity

Capacity of storage pools in Mbytes

storagePercentAvailable

Available capacity in the storage
pool, as a percentage of
storageCapacity

storageFootageSize

Size of footage within the storage
pool in Mbytes

storageFootageFiles

Number of footage files in the
storage pool.

servicelnfo infoServiceStatus Status of Al InfoService service
netSendHistStatus Status of Al NetSendHist service
schedulerStatus Status of Al Scheduler service
trackerNumber Number of tracker services
trackerID The ID of the tracker
Status of the Al Tracker service for
trackerStatus
the trackerID
. . . . . Notification sent when a login is
loginMonitor authorizedLoginNotif g Yes
successful
. . . Notification sent when an
unauthorizedLoginNotif Yes

unauthorized login is attempted

loginNotifylpAddress

IP address that the client is
connected from

loginNotifyUsername

Username that the client is
attempting to login with
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Table 7. Mib file details (Continued)

Category

Details

Description

Trap Yes/No

loginNotificationMessage

Message with additional details
about the login attempt

alarmMonitor

alarmNotif

Notification sent when an alarm
occurs or is marked

Yes

alarmNotifyCamerald

Camera ID of the camera that
recorded the alarm

alarmNotifyCameraName

Camera name of the camera that
recorded the alarm

alarmNotifyUserld

User ID of the user that marked the
alarm

alarmNotifyUserName

User name of the user that marked
the alarm

alarmNotifyMarkedDelay

Time alarm was marked

alarmNotifyFalseAlarm

Is this a false alarm

alarmNotifyRuleld

Rule ID of the rule causing the alarm

alarmNotifyRuleName

Rule name of the rule causing the
alarm

alarmNotifyDBId

ID of the alarm

alarmNotifyComment

Comments associated with the
alarm

alarmNotifyMSSinceChange

Number of milliseconds between
when the alarm occurred and when
it was detected

Symphony traps for unauthorized logins and all alarms when they occur or
when the user marks them.

Additional Tools and Information

If you prefer a command line tool instead of a GUI MIB Browser, you can use a free command line tool

(Net-SNMP) to walk the mib files. (The snmpwalk command will perform a sequence of chained GETNEXT
requests automatically.)

e Forinstructions, see Net-SNMP: http://net-snmp.sourceforge.net/

The following sites also provide information on SNMP:
e How SNMP Works: http://technet.microsoft.com/en-us/library/cc783142(WS.10).aspx
e How to effectively use a MIB Browser:

http://www.unleashnetworks.com/resources/articles/88-how-to-effectively-use-a-mib-browser.ht
ml

Chapter 2

114



http://technet.microsoft.com/en-us/library/cc783142(WS.10).aspx
http://www.unleashnetworks.com/resources/articles/88-how-to-effectively-use-a-mib-browser.html
http://www.unleashnetworks.com/resources/articles/88-how-to-effectively-use-a-mib-browser.html
http://net-snmp.sourceforge.net/

Using the DOS killall Utility with Symphony Services

Chapter 2

Using the DOS killall Utility with Symphony Services

Symphony comes with a dos utility that can be used to automatically start, stop or restart the Symphony Services.
This can be faster than individually managing the services from the Services console in Windows (accessed by

running Services.msc from the Start > Run command).

Note: Using the killall utility will not restart the SQL Database.

killall <command> Where next command is one of:

1 - Stop Services gracefully

2 - Terminate services

3 - Start services gracefully (restart web)

4 - Terminate services only if necessary

5 - Start services gracefully (leave web alone)
6 - <pid> - Kill the specified pid

7 - Restart web

8 - Get CPU usage from shared memory

9 - Same as 4 except will also kill infoservice
r - Restart services (killall 9, killall 5)

s - Restart services in sequence

t <tracker id> - Restart tracker <tracker id>

Example 3

To restart all system services:

From the command prompt, enter:
killall r
Click ENTER on keyboard to run command

Chapter 2
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Receiving Full Diagnostic Information

Symphony server provides detailed logs and monitoring functionality.

(o )[O el

Get Info - 10.234.1.34

B G

Choose Server: [10.234.1.34 - WIN-KST44FG22EK

Copy te Clipboard
-

r Info ---

CEU t 4a%
Physical Ram: 442 MB
Disk Space : 25%

ation Path etishSymphony'

: Rddress: WIN-K&T44FG25EK:50000 IP: 10.234.1.34 (Master) |

Ready

Figure 36. Get Info dialog box

Procedure

To receive full diagnostic information on your Symphony server:

1.

Chapter 2

From the Server menu, select Get Info. The Get Info dialog box opens. By default, CPU, RAM and
DISK information is displayed.

(Optional) Select the Verbose check box and click Get Info. More information is displayed.

(Optional) Click Copy to Clipboard. The text is copied to the clipboard.
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Managing Symphony Services
Symphony server runs the following core Services. All Symphony Services are prefixed with an "Al".
Table 8. Symphony Services
Service Description
Al InfoService Web Server running Symphony's web service which receives all requests from the
client.
Al NetSendHist Responsible for historical video streaming and historical .JPEG creation.
Responsible for polling hardware alarm inputs, cleaning video, running reports and
Al Scheduler .
searches, synchronizes CPU and other processes on system.
The process that performs video analysis, saves video to disk, live video streaming.
Al Tracker # L .
Each camera requires its own Al Tracker service.
Troubleshooting Tips
e Symphony requires the Al InfoService to be running properly. Normally connectivity issues
between the client and server are caused by a resource conflict between another process using
Port 50000, or a firewall preventing Symphony and the Al InfoService from communicating
properly.
e By default, Symphony installs a Microsoft SQL Server express database during the installation of
Symphony Server. Make sure the SQL Server (AIMETIS) service is started.
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Starting and Stopping Symphony Services

Symphony services can be stopped and started individually. Services can be individually restarted directly from
Symphony Client, or from Windows directly by using the Services Console.

If you do not have direct access to the Windows environment on the Symphony server, you can manage services
remotely using Symphony Client.

Procedure: Using Symphony Client

To manually stop and start individual services:

1. From the Server menu, select Services and then Manage Symphony Services. The Manage
Services dialog box opens.
2. Select which server to configure from the drop-down field above the Refresh button.
3. Select the services you want start or stop by clicking on the service under the Servername column.
4. Click the Toggle button and then click the Refresh button to see if the state of the server changed.
In State column, the service will indicate Running or Stopped.
Servicename State Error
Al Tracker 1 Running Mo Errar Ilocalhost - localhost j
» Al Tracker 2 Refresh |
SEL Server (AMETIS) Running Mo Errar
Al SNMP Registry Running Mo Errar Taggle |
AlInfaService Running Mo Errar PP N —
AlWatchdog Running Mo Errar I~ s_er\?i:eslcoans;ysfem ;:ﬁuzny
Al MetSendHist Running Mo Errar
Al Scheduler Running Mo Error Service Startup

{~ Log on as Local System account (default)

Pazsword: I

Apply |

Figure 37. Manage Services dialog box

By default, the Symphony Services start on startup of the operating system. If you do not want
Symphony Services to automatically start on system startup, clear the Automatically Start
Symphony Services on system startup check box.

You can change the Log on as Local System account for ALL services in the Service Startup
section.

Caution: Changing service states can adversely affect your Symphony
installation.
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Procedure: Using Windows directly

To restart the Symphony Services directly from Windows:
1. Inyour Windows operating system, select Start and then Run.
2. Enter Services.msc and click OK. The Services dialog box opens.

3. Load the Services Console. Right-click on the service you want to start, stop, or restart.

Virus Scanning

We recommend that you disable virus scanning software on the Symphony server. Virus scans use a large amount
of system resources to scan data. Virus scanning software, in some cases, locks each file it scans. Overall, it can
affect performance negatively.

Firewalling Symphony

Firewalling your server is a good way to reduce the chances of someone hacking in and damaging your system.

Procedure

To firewall your system:
1. From Control Panel, double-click on the Network Connections icon.
Right-click on your internet connection and select Properties.
Select the Advanced tab.

Select the Protect my computer check box.

2

3

4

5. Click Settings.
6. Ensure that none of the check boxes in the Services tab are selected.
7. Add a new service entry for every TCP port you want to allow through
8. Click the Add... button and fill in the dialog box.

9. Enter the name of your computer in the Name field.

10. Leave the Internal Port Number field empty. By default, Symphony uses the following ports:
Table 9. Default Ports

Port number |Description Configurable
50000 WS1 Yes
50001 WS2 Yes
50010 cameral live Yes
50012 cameral historical Yes
50020 camera?2 live Yes
50022 camera? historical Yes
50030 camera3 live Yes
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Table 9. Default Ports (Continued)

Port number |Description Configurable
50032 camera3 historical Yes
5045 health checks No

The port list in Table 9 on page 119 assumes you are publishing 3 cameras on the Symphony server PC behind the
firewall. If you are publishing more cameras on the PC, continue opening ports similar to those in Table 9.

* Important: If you are using Video Wall functionality, open port 50005 on the
client PC.

Publishing Symphony on a Non-Standard Port

By default, Symphony servers will use port 50000 as the default web port. However, in some cases the default
port may need to be changed. For example, if multiple servers are being published on the same external IP
address, the default ports of the subsequent server(s) need to be changed. By changing the BasePort (web port),
other ports will automatically change as well.

Procedure

To change the default ports:
1. In Symphony Client, from the Server menu, select Manual Configuration Editor.
2. Click Add a new setting... The fields under the column headings are activated.
3. Enter the following information:

e Type=Server

e Section = Main

e ID = (enter your Server ID)

e Key = BasePort

e Value = (enter your new default web port)

4. Restart the Symphony services.

HTTPS for AXIS

Forinstructions on setting up HTTPS for AXIS cameras, refer to the How To Configure HTTPS for AXIS document
on the Xnet: https://www.aimetis.com/Xnet/Downloads/documentation.aspx
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Configuring your Mail Server on Windows 2008 Server R2

Configuring your mail server allows your Symphony server to send email notifications when events happen.
Symphony may send emails as a result of Rule (Action) configuration or Subscriptions. Symphony will relay email
via an email server defined in the Subscriptions page.

e “Using Internal SMTP Server"
e “Using External SMTP Server” on page 122
e  “Windows 7 and Vista - SMTP not included” on page 122

Using Internal SMTP Server

Allow Symphony server to relay email through itself using Microsoft SMTP server.

Task 1: Install IS on the server

e Follow the instructions at
http://digitizor.com/2009/02/20/how-to-install-microsoft-iis-server-on-windows-7/

Task 2. Add SMTP Server:
1. Start the Server Manager MMC.
2. Inthe Features section, click Add Features.

3. Select SMTP Server.

Task 3. Configure the mail server
1. From the Windows Control Panel, double- click on the Administrative Tools icon.
2. Double-click on the Internet Information Services icon.

e If thisis not installed:

a. Go to Control Panel, Add/Remove Programs, and select Add/Remove Windows
Components.
b. Scroll to Internet Information Services, click Details, and add SMTP service.

Expand the tree. Right-click on Default SMTP Virtual Server and select Start if it is enabled.
Right-click on Default SMTP Virtual Server and select Properties.

Click the Access tab and then click Connection.

Select the Only the list below option and click Add.

Select the Single computer option and enter 127.0.0.1 as the IP address.

Click OK to close the Computer dialog box and click OK to close the Connection dialog box.

© ® N O v oW

Click the Relay... button.

10. Select the Only the list below option and click Add.

11. Select the Single computer option and enter 127.0.0.1 as the IP address.

12. Click OK to close the Computer dialog box.

13. Clear the Allow all computers that successfully authenticate to relay check box.

14. Click OK to close the Relay Restrictions dialog box.
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Using External SMTP Server

If an external SMTP server is used for Symphony email relaying, specify this address in the Subscriptions SMTP
field. Please note the connection to the SMTP service is not authenticated. Ensure that the SMTP server allows
for unauthenticated connections from the Symphony server IP address.

Windows 7 and Vista - SMTP not included

SMTP is not included in Vista or Windows 7. The 1IS 6.0 Manager shipped with Windows 7 is not aimed for IIS 7.5
Management. To manage IIS 7.5/FTP 7.5 shipped with Windows 7, you must use 1IS 7 Manager.

You have three options if you want SMTP support, so Symphony can email directly from the server:

e Use a server operating system and you then use the Microsoft supplied SMTP server.

e Use Windows 7 but use an external email gateway. For example, if the Symphony server is on the
office LAN with a local email server, Symphony can relay through that server.

e Install a 3rd party SMTP server that works with Windows 7.

Chapter 2
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Backup and Restore

We recommend that you backup the entire Symphony configuration after installation is complete, and that you
schedule automatic backups. The configuration file contains all settings of the server (but no recorded video).

Procedure

To access the Backup configuration:

e  From the Server menu, select Backup. The Backup dialog box opens.

Manual-backup

We recommend that you backup your entire Symphony configuration after you have completed the first time
setup. You may backup to your local PC or the server directly.

Procedure

To backup to local machine:
1. From the Server menu, select Backup. The Backup dialog box opens.
2. Select the To local machine check box.
3. Click Browse to select location to store the backup file.
4

Click OK when finished. The server backup will be stored in this location.

To backup to the server:
1. From the Server menu, select Backup. The Backup dialog box opens.
2. Select the To server check box.
3. Enter the location to store the backup file (this can also include a UNC path).
4

Click OK when finished. The server backup will be instantly stored in this location.
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Automatic Backups

Automatic backups will always be stored in the same location on the server. Only one backup can be saved at the
same time.

* Important: Each new backup will automatically overwrite the old one.

Procedure

To configure automatic backups of server configuration:
1. From the Server menu, select Backup. The Backup dialog box opens.
2. Select the Scheduled backup on server check box.

e  For daily backups, select the Daily check box for daily backups, and select an hour.

e  For weekly backups, select the Weekly check box, and select a day of the week and an
hour.

3. Click OK when finished.

Restore Configuration

Symphony can restore the entire configuration to a previous state, including Rule information, log files, alarm
masks, site maps and so on in configuration files.

The only data not contained in the configuration backup is video data.

Procedure

To restore configuration to a previous state:
1. From the Server menu, select Restore. The Restore dialog box opens.
2. Select the Restore server configuration check box.

e If the backup is on your local machine, select the From local machine option and click
Browse to select a backup file that was stored on your local PC.
e If the backup is directly on the server, select the From server option and enter the path
to the backup file.
3. To automatically restore the last auto-backup on the server, select the Last scheduled backup on
server option.

4. Click OK when finished.
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Symphony Web Access

Aimetis Symphony also includes a web interface. Each server has its own web interface.

The web interface is designed to mimic the windows rich client (Symphony Client) as much as possible. All core
features such as Alarm Log, Timeline, Reporting and live video streaming are included.

If the Camera Tree contains more than 100 devices, the Web Client shows video from cameras as separate pages,
navigated by forward and back buttons.

Procedure

To access the web interface:

1. Navigate to http://SERVERNAME:50000 (where SERVERNAME can be your windows hostname or
the IP address of the server).

2. Login.

3. Select a camera from the camera tree to view video.

Procedure

To access web based reporting:

e C(Click the Reports link. Visit Reports section for help on using reports.

Chapter 2
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Reports

Depending on write-permissions, the generated report will be stored in the \Data\Reports folder on the master
server machine. (This default folder is designated during the initial Symphony installation and setup or can be
changed in the Server Path field.

If there are multiple servers in a farm, all the servers must have the same directory tree structure for the path
being used to save reports. The path specified in Figure 38, for example, must exist on all servers in the farm.

S 'Report Designer

Cancel

Emnail File:

Server Path; IC:\USers\huiId\Documents\Repons

Distribution Repart Format(s)
¥ POF Docurnent (FOF)

¥ Comma Separated Text (C5W)
¥ Extersible Markup Language (XML

¥ Generate Image

| Previous Page || Mext Page |

Figure 38. Server Path field for saving a generated report

Recommended: Set up a writable, shared folder on a machine and designate it as the reports repository using
the Server Path field.
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File Distribution Permissions for Scheduled versus Manual Reports

When designating a folder on the system to save a generated report (Send Report>File), you must be aware of
the following.

I's IReport: Obj Lirits 2 a Line Repart

= Table [ Graph

Export To...  Columns... | Send Report

Emal |
Drag a colurnn header here {File y that column
Date Interval End | Coul \ Count Out
16/01/2012  16:17:27
16/01/2012  17:117:27
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16/01/2012  20:17:27 u]
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17/01f2012  00:17:27
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Figure 39. Send Report > File saves a generated report

e For scheduled reports, the files will be saved using the account (identity) of the user running the
services (in particular InfoService). So that account must have permission to write to the default
\Reports folder. If a user changes the default path (Server Path in File subtab of Distribution tab
in Reports Designer), then the user must ensure that the Windows account the InfoService is
running as can write to that new folder.

¢ For manual reports, the files will be saved using the account of the user logged in running the
report. If restricted user does not have access to write to say c:\windows, and changes the default
path (Server Path in File subtab of Distribution tab in Reports Designer), the report will NOT be
saved.
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This guide is for informational purposes only. AIMETIS MAKES NO WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, AS TO THE
INFORMATION IN THIS DOCUMENT.

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no part of this
document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means (electronic,
mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of Aimetis Corp.
Aimetis may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in
this document. Except as expressly provided in any written license agreement from Aimetis, the furnishing of this document does not
give you any license to these patents, trademarks, copyrights, or other intellectual property.

Aimetis and Aimetis Symphony are either registered trademarks or trademarks of Aimetis Corp. in the United States and/or other
countries.

Portions Copyright © 1993-2013 ARH Inc.

Portions of this software are based in part on the work of the Independent JPEG Group.
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